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Before You Begin UNIX and Linux Installation

Before you begin, please take the time to go over the guidelines for installing Advanced Design System (ADS) on a
UNIX or Linux system. For last-minute program and documentation information, refer to the Release Notes document
on our website at:

http://www.agilent.com/find/eesof-docs

Choose Advanced Design System > Release Notes: 2008

Note the Changes in ADS 2008

© Important
If you have systems running older versions of ADS, see Changes in ADS 2008 for a brief description of changes
in the latest ADS versions and their impact on systems with older versions installed.

Changes in ADS 2008

Description and Reference to Details Version Introduced and Impact
Maintenance Software Releases (MSR) replaced by ADS 2008
Update releases. MSRs are no longer available.

See Update and Maintenance Software Releases.

Supported platforms changed. ADS 2008
See Check the System Requirements. HP-UX is no longer supported.
Solaris 8 and 9 are no longer supported.
Red Hat Linux WS 3.x is no longer supported.

Supported media type changed ADS 2008
See Check the System Requirements. Installation images now on DVD.
Supported compilers changed 2008



http://www.agilent.com/find/eesof-docs

Advanced Design System 2008

See Check the System Requirements

Supported HDL simulators changed
See Check the System Requirements

Recommended patches updated
See Operating Systems Details

Table showing required compilers added
See User Complied Models

Table showing license codewords added.
See License Codewords.

Dataset size limitation removed.
See Dataset Types.

Support for HDL64 Cosim changed
See Supported Features on 64-bit Operating Systems

Support for downloading installation images added
See Installing Advanced Design System

The codeword version changed to 2.7 from 2.6.
See Installing Licenses

The version for the license server (Imgrd) has changed
to FLEXnet 11.4.1 from FLEXnet 10.8

See Start the License Server (Imgrd)
On 64-bit operating systems, you can use 64-bit

simulators (default) or 32-bit simulators
See Starting ADS in Verbose Mode (Debug Mode)

SunStudio 11 and gcc 4.1.1 are now supported

ADS 2008
Only IUS5.8 and ModelSim SE 6.3a are now supported

ADS 2006 Update 1
Patches now listed for all supported platforms

ADS 2006 Update 1
Table shows required compilers for the current release
and back to ADS 2004A

ADS 2008
Table shows license codeword part numbers,
descriptions, and codeword names.

ADS 2008

Datasets larger than 2 GB are now allowed.

Datasets created by ADS 2008 software (and subsequent
releases) are not readable by earlier versions of the ADS
software.

ADS 2006 Update 2
HDL64 Cosim is now listed as native 64-bit on 64-bit
Solaris and Linux operating systems

ADS 2006A
Installation images available for download

ADS 2008
You must obtain new FLEXnet license codewords from
Agilent EEsof EDA

ADS 2008
Impacts all systems, license servers, and license
administration scripts

ADS 2006A
Impacts Analog/RF, Momentum, and Ptolemy simulators

Update and Maintenance Software Releases

Update releases provide specific new features plus all the defect repairs normally found in a Maintenance Software
Release (MSR). Since the Update release contains all the defect repairs of the MSR, MSRs will no longer be available.

An Update release is an entirely new installation of ADS and is installed in its own directory. Therefore, if disk space is
an issue, uninstall your previous version of ADS before installing an Update. If disk space is not an issue, you can
install an update release in its own directory. Although your ADS 2008 licenses will work with ADS 2008 Update
releases, you may need additional licenses to run multiple releases concurrently.
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Check the System Requirements

Be sure your hardware and software configuration meets the following minimum hardware and system requirements
to install and/or run ADS, including RAM, disk space, operating systems, patches and updates, etc. Keep in mind that
minimum requirements are just that, and they may not provide adequate performance and responsiveness. For the
latest system requirement information, refer to the UNIX and Linux Installation document on our website at:

http://www.agilent.com/find/eesof-docs

System Requirements

Requirement Solaris (on SPARC) Linux

32-bit Operating System (see Solaris 10 Redhat RHEL WS 4.x, Novell SUSE

"Operating Systems Details") SLES 9

64-bit Operating System (see Solaris 10 with 64-bit support turned | Redhat RHEL WS 4.0, Novell SUSE

"Supported Features on 64-bit on SLES 9 (64-bit AMD Opteron and

Operating Systems") Intel EM64T processors)

Displays High-resolution color only. (Super VGA, 1024x768, 15-inch monitor
minimum)

Processor ADS is not supported on Intel Intel Pentium® 4 or better, or AMD
Itanium-based workstations. XP 3000 or better.

RAM 1 GB RAM recommended minimum. Additional RAM will enable you to

simulate larger designs. However, on a 32-bit operating system, its
processes cannot use more than 2 GB regardless of the maximum
addressable memory available on your system.

Swap Space 512 MB recommended minimum, increased swap space may be required for
larger designs.

Web Browser ADS documentation is HTML-based and displayed via a web browser.
Netscape 4.5 or higher is required.

Mozilla 1.7 or Firefox 1.5.0.4 or better are the recommended web browsers.
To view the pdf files, Acrobat Reader 5.0 or higher is recommended.

Java Virtual Machine and JavaScript must be enabled on your browser for the
documentation to appear correctly. You can use your browser's internal Java
support or download and install a Java plug-in. If you install a Java plug-in,
the minimum recommended version is Sun Java Plug-in 1.3.

To use the documentation search engine on 64-bit Novell SUSE SLES 9.3
systems, 32-bit Mozilla from SuSe (mozilla-1.7.8-5.13.i586.rpm) and the
32-bit JRE 1.6.9_3 from Sun (jre-6u3-linux-i586.rpm) is required.

Hard Disk Space ADS requires about 1.3 GB for a minimum installation, 2.5 GB for a typical
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installation, and 3.6 GB for a complete installation.

Security Device

ADS software codewords are secured
to a network server using FLEXIm
server software or locked to an
individual computer host ID number.

ADS software codewords are secured
to a network server using FLEXIm
server software or locked to an
external device (FLEXid hardware
security key) attached to the USB
port (only applies to 32-bit code) or
locked to a LAN ethernet card.

Supported Printers

ADS uses Xprinter for all PostScript®, HPGL2 and PCL printing. For a
complete list of output devices supported with Xprinter, consult the text file
called filename_map.txt, located in the directory path: /xprinter/ppds. For
instructions on UNIX and Linux printing and plotting, refer to "Printing and

Plotting".

Supported Media Type

DVD or high speed internet access required for program installation.

Window Manager

Motif™ V.1.1/1.2 Open Windows 3.0,
or CDE

KDE or GNOME

Compiler (required only for model
development) (see "User Complied
Models")

C++ and CC:
SunStudio 11

C++:
gcc Version 4.1.1

HDL simulator (required only for HDL
cosimulation)

These HDL simulators are the latest versions supported on ADS:
- Mentor Graphics ModelSim SE Plus 6.3a (both 32-bit and 64-bit mode)
- Cadence NCSim IUS5.8 for both 64-bit and 32-bit simulation (Only on ADS

supported Linux and Sun).

- Cadence VerilogXL IUS5.8 for only 32-bit simulation (Only on ADS

supported Linux and Sun).

Solaris Details

Solaris 10

Red Hat Linux Details

Operating Systems Details

Solaris operating systems are not supported on
Intel-compatible chips.

Solaris requires the following patches (exact patch
numbers may change as new patches are issued):
You can find patches at

http://sunsolve.sun.com/pub-cgi/show.pl?target=patchpage

119689-06 (libc.so.1 Patch)

117461-08 (Id patch)

118822-27 (kernel patch)

118707-04 (Expert3D IFB Graphics Patch)

118712-08 (Sun XVR-100 Graphics Accelerator Patch)
118711-02 (M64 Graphics Patch)

118708-11 (Sun XVR-1200 Graphics Accelerator Patch)

RFDE requires that the Korn shell (ksh) be installed with

Red Hat Linux 7.2/7.3/8. For installation information, see
the Red Hat Linux Installation Guide at

http://www.redhat.com/docs/manuals/linux/ or the Red


http://sunsolve.sun.com/pub-cgi/show.pl?target=patchpage
http://www.redhat.com/docs/manuals/linux/

Linux RHEL 4.0 32-bit

Linux RHEL 4.0 64bit (x86_64)

Novell Linux Details

Linux SUSE SLES 9 32-bit

Linux SUSE SLES 9 (x86_64)

User Complied Models

Advanced Design System 2008

Hat Linux documentation on your installation DVD.

Agilent EEsof recommends the following patches for Red
Hat Linux systems:

Recommended with all base errata in RHEL 4 Update 1
kernel-2.6.9-11.EL
glibc-2.3.4-2.9
elfutils-0.97.5
elfutils-libelf-0.97.5

Recommended with all base errata in RHEL 4 Update 1
kernel-2.6.9-11.EL
glibc-2.3.4-2.9
elfutils-0.91.3
elfutils-libelf-0.91.3

Agilent EEsof recommends the following patches for
Novell Linux systems:

All Recommended with all base errata in SLES 9 SP3
kernel-2.6.5-7.244
glibc-2.3.3-98.61
libelf-0.8.5-32.4
libelf-32bit-9-200511222041
termcap-32bit-9-200407011229
ncompress-4.2.4

All Recommended with all base errata in SLES 9 SP3
kernel-2.6.5-7.244
glibc-2.3.3-98.61
libelf-0.8.5-32.4
libelf-32bit-9-200511222041
termcap-32bit-9-200407011229
ncompress-4.2.4

For dynamic User Compiled Models, recompilation is required only for platforms where the compiler has been
upgraded. If you are doing 32-bit models, going from 2006 Update to 2008, the compilers have been upgraded for
Sun and Linux so recompilation is required.

For static User Compiled Models, recompilation is required for every upgrade.

The following table shows the required compilers for the current release and back to ADS 2004A:

ADS Release

Solaris HP-UX RH Linux

2004A C++ and CC: C++: C++:
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Sun C++ 5.5 Patch aC++ or HP ANSI C++ gcc Version 3.3.2
113817-08 B3910B A.03.52
C.

cc or HP ANSI C++ B3910B
A.03.52 and B.11.11.04

2005A C++ and CC: C++: C++:
Sun C++ 5.5 Patch aC++ or HP ANSI C++ gcc Version 3.3.2
113817-08 B3910B A.03.52
C.

cc or HP ANSI C++ B3910B
A.03.52 and B.11.11.04

2006A and 2006 Update C++ and CC: C++: C++:
Sun C++ 5.7 2005/01/07 aCC HP ANSI C++ B3910B  gcc Version 3.3.2
(Sun Studio 10) A.03.63
C:

cc or B3899BA B.11.11.12
HP C/ANSI C Developer's

Bundle
2008 C++: CC: HP-UX is no longer C++:
SunStudio 11 supported gcc Version 4.1.1

Checking the Operating System

To determine the version that you are currently running, at the system prompt type:

unane -r (All UNIX and Linux platforms)

Get Codewords for ADS 2008

You must obtain new FLEXnet license codewords to run ADS 2008. You will be able to run only those items for which
you have codewords. Before requesting codewords, please review the information in Special License Issues.

 Note

As with most EDA software, each copy of Agilent EEsof software operating simultaneously requires a license for
the features being used. This is true whether the software is being run on separate computers, different
processors within one computer, or different cores within a processor: each concurrent copy requires a license.

You can request codewords on the Web at:
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http://www.agilent.com/find/eesof-support

Scroll to Business Support/EEsof Codewords and select EEsof Codeword Request.

The codewords are then emailed to you in a license file called license.lic.

The hardware key is generally shipped with the software disks. If you do not have one, contact Agilent EEsof Business

Support at 1-800-507-6274.

For details on both methods of securing codewords refer to Setting Up Licenses.

For details about license codewords required for simulators, design libraries, components, and other ADS products,

see the following table.

License Codewords

Part Number

E4687L/TBL
E5610L/TBL
E5611L/TBL
E5612L/TBL
E5613L/TBL
E5614L/TBL
E5615L/TBL
E5616L/TBL
E5617L/TBL
E5618L/TBL
E5623L/TBL
E5720L

E5771TBL
E5772TBL

E5773TBL

DESCRIPTION
Broadband SPICE Model Generator
Passive Circuit DesignGuide
Power Amplifier DesignGuide
Oscillator DesignGuide
Phase-Locked Loop DesignGuide
Linearizer DesignGuide
Mixer DesignGuide
Bluetooth DesignGuide
RF System DesignGuide
Filter DesignGuide
Design Guide Bundle

Connection Manager

RFIC Limited Term Package

RF and Microwave Limited Term
Package

CommSys Limited Term Package

11

NAME
mom_spice_broadband
dg_passives
dg_pwr_amp
dg_oscillator
dg_pll
dg_linear
dg_mixer
dg_multi_carrier
dg_commsys
dg_filter
pb_design_guides

link_connect_mgr,
link_measampmodeling

Itp_rfic_dg
ltp_rf_mw_dg

ltp_comm_dsp_dg


http://www.agilent.com/find/eesof-support
http://edocs.soco.agilent.com/display/ads2008/Setting+Up+Licenses+for+UNIX+and+Linux+Installation#SettingUpLicensesforUNIXandLinuxInstallation-SettingUpLicenses

E5774TBL

E5776TBL
E5777TBL
E5778TBL

E5779TBL

E8811L/TBL

E8812L/TBL

E8819L/TBL

E8822L/TBL
E8823L/TBL
E8824L/TBL
E8825L/TBL
E8827L/TBL
E8828L/TBL
E8829L

E8850L/TBL

E8851L/TBL

E8852L/TBL
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Integrated Design Limited Term
Package

MIMIC Limited Term Package
Analog Designer Time Based License

RF & Microwave Entry Level Time
Based License

DesignGuide Bundle Limited Term
Package

MMIC Designer Pro

MMIC Designer Premier

EMDS for ADS Suite

Agilent Ptolemy Fixed Point Analysis
Agilent Ptolemy Simulator
Statistical Design

Digital Filter

Advanced Comms Models

Signal Integrity Verification Toolkit
Comms Verification Bundle

Communication System Designer
(node locked only)

Communications System Designer
Pro

Communications System Designer
Premier
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Itp_intergrated_dg

Itp_mmic
ltp_analog

ltp_rfmw_entry

Itp_design_guides

ads_datadisplay, ads_layout,
ads_schematic, mom_opt, mom_vis,
momentum, mom_obj,
sim_harmonic, sim_linear,
trans_gdsii

ads_datadisplay, ads_drc,
ads_layout, ads_schematic,
dg_passives, mom_adv_composer,
mom_opt, mom_vis, momentum,
mom_obj, sim_harmonic, sim_linear,
sim_statistics, trans_dxf_flat,
trans_dxf_hier, trans_gdsii,
trans_gerber

emds_environment,
emds_3d_engine_a, emds_for_ads

sim_fixedpoint
sim_systime
sim_statistics
sim_dfilter
mdl_adv_comm
ads_si_verification
b_commes_verification

ads_datadisplay, ads_lite,
mdl_systemlib, sim_syslinearlite

ads_datadisplay, ads_schematic,
mdl_adv_comm, mdl|_systemlib,
sim_dfilter, sim_fixedpoint,
sim_statistics, sim_syslinear,
sim_systime, sim_usermodels

ads_datadisplay, ads_schematic,
mdl_ant_array, mdl_ant_cdma,
mdI_ant_gsm, mdl_ant_wcdma,



E8853L/TBL
E8854L/TBL
E8856L/TBL

E8857L

E8859L

E8866L/TBL
E8868L
E8869L/TBL
E8870L/TBL
E8871L/TBL
E8873L

E8874L

E8875L

E8877L

E8878L
E8879L

E8881L/TBL
E8882L/TBL
E8883L/TBL
E8884L/TBL
E8885L/TBL
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RF System Simulator
RF Systems Models

Antenna & Propagation Models

CDMA Design Library
GSM Design Library

HDL co-sim for Agilent Ptolemy
DTV Design Library

Mobile WiMax Wireless Library
Fixed WiMax Wireless Library
802.11n Wireless Library

TD-SCDMA Design Library
WLAN Design Library

3GPP W-CDMA Design Library

CDMA2000-compliant Design Library

CDMA1XEV Design Library

EDGE Design Library

Linear Simulator

Harmonic Balance Simulator
Circuit Envelope Simulator
High Frequency Spice

Convolution Simulator
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mdl_adv_comm, mdI_antenna,
mdI_propagation, mdl_systemlib,
sim_dfilter, sim_fixedpoint,
sim_hdl_cosim, sim_statistics,
sim_syslinear, sim_systime,
sim_usermodels

sim_syslinear
mdl_systemlib

mdl_ant_array, mdl_ant_cdma,
mdl_ant_gsm, mdl_ant_wcdma,
mdI_antenna, mdl_propagation

mdl_ant_cdma, mdl_antenna,
mdl_cdma

mdl_ant_gsm, mdl_antenna,
mdl_gsm

sim_hdl_cosim

mdl_dtvtrans

mdl_wimax_mobile, mdl_adv_comm
mdl_wimax_fixed, mdl_adv_comm
md|_802_11_n, mdl_adv_comm

mdl_antenna, mdl_propagation,
mdl_tdscdma

mdI|_antenna, mdl_wlan,
md|_propagation

mdl_ant_array, mdl_ant_wcdma,
mdI_antenna, mdl_propagation,
mdIl_wcdma3g

mdl_ant_cdma, mdl_antenna,
mdl_cdma2k

mdl_1xev

mdl_ant_gsm, mdl_antenna,
mdl_edge

sim_linear

sim_harmonic
sim_envelope
sim_transient

sim_convolution



E8886L/TBL
E8887L/TBL

E8888L/TBL

E8889L/TBL

E8890L/TBL
E8894L/TBL
E8895L/TBL
E8896L/TBL

E8897L/TBL
E8898L/TBL
E8899L/TBL

E8900L/TBL
E8901L/TBL
E8902L/TBL
E8903L/TBL
E8904L/TBL
E8905L/TBL
E8906L/TBL
E8907L/TBL
E8909L/TBL

E8910L/TBL

E8911L/TBL
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Verilog-A Compiler
HSUPA Design Library

RFIC Designer Pro

RFIC Designer Premier

Analog Model Development Kit
RFIP Encoder
3GPP LTE Wireless Library

Wireless Networking Verification
Bundle

2G/3G Cellular Verification Bundle
Mature Wireless Verification Bundle

Integrated Wireless Verification
Library

Design Environment

Data Display

Layout

IGES Translator

GDSII Translator

DXF Translator

Gerber & DXF Translator

ADS Layout Design Rule Checker

Layout Translator Bundle
Microwave Circuit Designer (node

locked only)

Microwave Circuit Designer Pro
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sim_veriloga

mdl_hsupa, mdl_wcdma3g,
mdl_adv_comm, mdI_ant_array,
mdI_ant_wcdma, mdl_antenna,
md|_propagation

ads_datadisplay, ads_schematic,
sim_envelope, sim_harmonic,
sim_linear, sim_transient

ads_datadisplay, ads_schematic,
mdl|_systemlib, sim_convolution,
sim_envelope, sim_harmonic,
sim_linear, sim_statistics,
sim_transient, sim_usermodels

sim_usermodels
ads_encoder
mdl_3gpp_lte

b_mdl_wireless_network

b_mdl_cellular
b_mdI_mature

b_mdI_wireless_integrated

ads_schematic
ads_datadisplay

ads_layout

trans_iges

trans_gdsii

trans_dxf_hier
trans_dxf_flat, trans_gerber
ads_drc

trans_dxf_flat, trans_dxf_hier,
trans_gdsii, trans_gerber, trans_iges

ads_datadisplay, ads_schematic,
sim_harmonic, sim_linear

ads_datadisplay, ads_layout,
ads_schematic, sim_harmonic,
sim_linear, sim_statistics



E8912L/TBL

E8914L/TBL

E8915L/TBL

E8917L/TBL
E8919L/TBL

E8920L/TBL

E8921L/TBL
E8922L/TBL
E8925L/TBL
E8926L/TBL
E8933L/TBL

E8937L/TBL
E8940L

E8942L/TBL

E8943L/TBL

E8949L/TBL
E8950L/TBL
E8951L/TBL
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Microwave Circuit Designer Premier

Physical Designer Pro

Physical Designer Premier

Gerber File Importer

Momentum Circuit Designer

Momentum EM Bundle

Momentum Planar EM Simulator
Momentum Visualization
Momentum Optimization
Advanced Model Composer

WiMedia Wireless Library

Verilog-AMS Compiler
RF Designer (node locked only)

RF Board Designer Pro

RF Board Designer Premier

IBIS Model Library
RF Passive Circuit Models

Multilayer Interconnect Models
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ads_datadisplay, ads_layout,
ads_schematic, mdl_systemlib,
sim_envelope, sim_harmonic,
sim_linear, sim_statistics,
sim_usermodels

ads_drc, ads_layout, trans_dxf_flat,

trans_dxf_hier, trans_gdsii,
trans_gerber

ads_drc, ads_layout, mom_opt,
mom_vis, momentum, mom_obj,
trans_dxf_flat, trans_dxf_hier,
trans_gdsii, trans_gerber

trans_gerber_union

ads_datadisplay, ads_layout,
ads_schematic, momentum,
mom_obj, sim_linear

momentum, mom_obj, mom_opt,
mom_vis

momentum, mom_obj
mom_Vis

mom_opt
mom_adv_composer

mdl_wimedia, mdl_antenna,
md|_propagation, mdl_adv_comm

sim_verilog_ams

ads_datadisplay, ads_lite,
sim_linearlite

ads_datadisplay, ads_layout,
ads_schematic, mdl_rfelements,
sim_harmonic, sim_linear,
sim__statistics

ads_datadisplay, ads_layout,
ads_schematic, mdl_multilayer,
mdI_rfelements, mdl_systemlib,
sim_envelope, sim_harmonic,
sim_linear, sim_statistics

mdl_ibis
mdl_rfelements

mdl_multilayer



E8962L/TBL
E8963L/TBL

E8970L/TBL
E8971L/TBL
E8972L/TBL
E8973L/TBL

E8974L/TBL

E8975L/TBL

E8976L/TBL

E8977L/TBL

E8982L/TBL
E8983L/TBL
E8984L/TBL
E8986L/TBL

E8987L/TBL

E8988L/TBL
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Legacy DXF Heirarchical Translator

Legacy Gerber and DXF Flattened
Translator

RFIC Dynamic Link for Cadence
ADS Bundle License - Linear
ADS Bundle License - Linear-Layout

ADS Bundle License -
Linear-EM-Layout

ADS Bundle License - Linear-Non
Linear

ADS Bundle License - Linear-Non
Linear-Layout

ADS Bundle License - Linear-Non
Linear-EM-Layout

ADS Bundle License - Linear-Non
Linear-SPICE

SiP Module Designer
SiP Module Designer Pro
SiP Module Designer Premier

High Speed Analog Designer

High Speed Analog Designer Pro

High Speed Analog Designer Premier

16

trans_dxf_heir_legacy

trans_dxf_flat_legacy,
trans_gerber_legacy

trans_idf
pb_ak1
pb_ak2
pb_ak3

pb_ak4

pb_ak5

pb_ak6

pb_ak7

b_sipmodule_designer
b_sipmodule_designer_pro
b_sipmodule_designer_premier

ads_schematic, ads_datadisplay,
sim_linear, sim_transient,
dg_passives, mdl_ibis,
mom_spice_broadband

ads_schematic, ads_datadisplay,
ads_layout, ads_si_verification,
sim_linear, sim_transient,
sim_convolution, sim_statistics,
mdl_rfelements, mdl_ibis,
mdI_multilayer, momentum,
mom_obj, mom_spice_broadband,
mom_vis, trans_dxf_flat,
trans_dxf_hier, trans_gdsii,
trans_gerber, trans_iges,
dg_passives

ads_schematic, ads_datadisplay,
ads_layout, ads_si_verification,
sim_linear, sim_transient,
sim_convolution, sim_harmonic,
sim_statistics, sim_systime,
sim_usermodels, mdI_rfelements,
momentum, mom_obj, mom_vis,



E9010L/TBL
E9011L/TBL
E9012L/TBL

W1105L/TBL

W1106L/TBL

W1107L/TBL

W11121/W1112TBL

W1120L/TBL
W1121L/TBL

W1421L/TBL

W1422L/TBL

W2001L/TBL

W2002/LTBL

W2003L/TBL

W2005L/TBL
W2010L/TBL

W2011L/TBL

Advanced Design System 2008

ADS Signal Integrity Designer
ADS Signal Integrity Designer Pro

ADS Signal Integrity Designer
Premier

GoldenGate/RFDE Momentum
Integration

GoldenGate/RFDE Momentum Suite

RFDE Wireless Test Bench
RFIC Combo - GoldenGate/RFDE/ADS

Ptolemy AMSD Integration

Ptolemy AMSD Suite

Genesys Synthesis for ADS
RF Architect for ADS

GoldenGate Simulator

GoldenGate Superlicense 10x
time-based

GoldenGate Superlicense 20x
time-based

PLL Simulator for GoldenGate

GoldenGate Core

GoldenGate RFIC Designer
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mom_opt, mom_spice_broadband,
trans_dxf_flat, trans_dxf_hier,
trans_gdsii, trans_gerber,
trans_iges, mdl_multilayer,
mdl_systemlib, mdI_ibis,
dg_passives, dg_filter

pb_si_designer
pb_si_designer_pro

pb_si_designer_3,
emds_environment,
emds_3d_engine_a

rfde_environment,
rfde_momentum_int,
ads_datadisplay

rfde_environment,
rfde_momentum_int,
ads_datadisplay, momentum,
mom_obj, mom_vis

rfde_wtb_int

Itp_rfic_rfde_combo_gg, gpp, gqwave,
skilld, va2gg

rfde_amsd_int, rfde_environment

rfde_amsd_int, rfde_environment,
sim_systime,
ads_datadisplay

ads_circuit_synthesis
ads_rf_architect

ggsim, gpp, qwave, skilld, va2gg,
xplx, ads_datadisplay,
rfde_environment

licen ggsimsl10, burstsim

licen ggsimsl20, burstsim

ggpll

gpp, qwave, va2gg, xplx, ggsimcore,
skilldcore

rfde_premier_gg, gpp, qwave, skilld,
va2gg
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W2013L/TBL GoldenGate Enterprise Itp_intdesrfde_combo_gg, gpp,
gwave, skilld, va2gg

Special License Issues

Please consider the following issues before requesting a license.

Linux Systems

If you will be using your LAN card's Ethernet ID to run the FLEXnet licensing system on your PC and you have more
than one network card (such as a permanent LAN card and a removable WLAN card) inform your Agilent sales
representative to assist you in selecting the correct ID when you request licenses. Use the following command to read
the ID, and copy the address returned for Ethernet HWAddr. Then ask the Agilent EEsof Business Support to tie this
ID to your ADS codewords when you submit your Codeword Request Form.

/sbin/ifconfig

Back Up Data from Previous Installations

You can retain earlier installations of ADS and ADS 2008 in separate directories on the same machine, but you cannot
install version 2008 over a previous ADS installation. This also applies to an Early Access (Beta) 2008 version.

Before you delete a previous installation:

e Copy your projects, customized configuration files, and other data.
e Copy your license file from the <install_dir>/licenses directory.

For details on running multiple ADS versions, refer to Using Multiple ADS Versions.

Check Available Memory

You need a minimum of 512 MB of memory installed on your system. More memory results in better overall system
performance for some design work.

Linux Systems
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To check the amount of memory on your system, enter the following command at a command prompt:
/ bi n/ dnesg

Look for the Memory line which includes the amount of available memory.

Solaris Systems

To check the amount of memory on your system, enter the following command at a command prompt:
[usr/bin/dnesg | nore (Solaris)

Look for the avail mem= and mem= lines.

This command lists the messages displayed during the last boot of the system.

Check Available Disk Space

The amount of disk space required depends on the ADS products that you want to install. Approximately 3.5 GB of
disk space is required to install all ADS products. To display the available disk space, at the prompt enter the
command for the workstation you are using:

Workstation Command
Red Hat Linux df -k
Solaris df -k

) Note

ADS requires at least 20-30 MB of free disk space under /tmp and var/tmp to work properly.

Checking Swap Space

The recommended minimum swap space is 300 MB. Very large designs, and designs with many hierarchical levels,
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could require more.

To check the current amount of swap space on your system, enter one of the following:

Workstation Command

Red Hat Linux /Jusr/bin/free -t

Solaris /usr/sbin/swap -s

Defining an Install Location

Be sure you have permissions to write to the disk drive on which you want to install ADS.

¢ You do not need to install as root, although you may need root privileges to mount and unmount the installation

DVD.
o If installed as root, all ADS files should have at least read permission for all users.

You can re-run the installation program to install items you chose not to install the first time through.

For details on install steps and options, refer to Installing Advanced Design System.

 Note
The installation program does not support cross-platform installations. Use the correct platform-specific

installation disk or download for your system.

Dataset Types

Due to a change that removed the former limitation on dataset file sizes, datasets created by ADS 2008 (and
subsequent releases) are not readable by earlier versions of the ADS. However, two new command-line programs are

available that can identify (and if necessary change) the type of a given dataset.

dstype

The dstype program identifies the type of one or more specified datasets.

Usage:

dstype <dataset fil ename> ...
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This program displays the type of the specified dataset filename(s). The filenames must include the .ds dataset file
extension. UNIX wildcards may be used in dataset filenames. More than one filename can be specified on the
command-line. Example:

$ dstype test.ds hbtest.ds junkfile.ds

test.ds: Agilent EEsof dataset, Release 2008 for mat
hbt est. ds: Agilent EEsof dataset, Release 2006A fornat
junkfile.ds: unknown file type (not a valid dataset)

The types are referred to as Release 2006A format and Release 2008 format. Release 2006A format applies to a
dataset produced by any version of ADS before 2008. The Release 2008 format applies to a dataset produced by ADS
2008 or later versions.

dsconvert

The dsconvert program performs type-conversion between the two data set types.

Usage:

dsconvert [-f] <from dataset> <to_dataset >

Where <from dat aset > and <t o_dat aset > are the source and destination dataset filenames, respectively, including
the .ds extension. Only one file can be converted at a time; do not use wildcards with the dsconvert program.

To prevent accidental overwriting, the destination dataset must not exist, unless the -f option is given. The -f option
forces the overwrite/deletion of an existing destination dataset.

Conversion can be in either direction:

o If <from dat aset > is in Release 2008 format, the program converts it to the Release 2006A format.

o If <from dat aset > is in Release 2006A format, the program converts it to the Release 2008 format. (However, it
is not actually necessary to perform this type of conversion, as ADS 2008 is capable of reading datasets created
by earlier versions.)

Supported Features on 64-bit Operating Systems

The following simulators are supported when ADS is installed on a 64-bit Solaris or Linux operating system:

e 64-bit Analog/RF
e 64-bit Momentum
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e 64-bit Ptolemy

If you want to run these simulators in 32-bit mode or you want to use features that are not available on a 64-bit
operating system, you can launch ADS in 32-bit mode. See Using 32-bit Simulators on a 64-bit Operating System.

The following tables provide details about the supported features when ADS is installed on a 64-bit operating system:

Functionality Solaris64 Linux RedHat64

Large Schematics, Netlists, Layouts 32-bit mode 32-bit mode
Data Display / Large Datasets native 64-bit native 64-bit
3rd Party: DRC, Translators 32-bit mode 32-bit mode
Utilities (LineCalc, Smith, 32-bit mode 32-bit mode
DesignGuides)
Connection Manager Client 32-bit mode 32-bit mode
Connection Manager Server n/a n/a
Legacy Instrument Server n/a n/a
Dynamic Link to Cadence 32-bit mode 32-bit mode
DSP Filter Tool 32-bit mode 32-bit mode
Data Display AEL Expressions based 32-bit mode 32-bit mode
on ADS Ptolemy
FlexLM License Server 32-bit mode 32-bit mode

Circuit Simulation Solaris64 Linux RedHat64
Circuit Simulation Engine, Local native 64-bit native 64-bit
Simulation (assume no external
cosims or linked executables)
Circuit Simulation Engine, Remote native 64-bit native 64-bit

Simulation (assume no external
cosims or linked executables)

Verilog-A

User-Compiled Models, SimKit, MINT

LSF

A/RF Modulated-Source-DSP-Based
(assume no 3rd party cosims)

all native 64-bit only, or all 32-bit in
compatibility mode, no 64/32-bit
mixture

all native 64-bit only, or all 32-bit in
compatibility mode, no 64/32-bit
mixture

n/a

native 64-bit
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A/RF Wireless Test Benches (assume  native 64-bit native 64-bit
no 3rd party cosims)

System Simulation Solaris64 Linux RedHat64

Ptolemy Engine (assume no native 64-bit native 64-bit
user-compiled models)

Ptolemy Remote Simulation native 64-bit native 64-bit

Ptolemy LSF native 64-bit native 64-bit

Ptolemy, User-Compiled C all native 64-bit only, or all 32-bit in  all native 64-bit only, or all 32-bit in
compatibility mode, no 64/32-bit compatibility mode, no 64/32-bit
mixture mixture

Matlab64 Cosim 32-bit mode 32-bit mode

HDL Cosim (NCSim and ModelSim) native 64-bit native 64-bit

HDL Cosim (VerilogXL) 32-bit mode 32-bit mode

89601 VSA Cosim n/a n/a

Ptolemy, Connection Manager 32-bit mode 32-bit mode

Client/Objects (except for 89601 VSA

link)

Ptolemy, Legacy Instrument Links 32-bit mode 32-bit mode

(non-connection manager)

Momentum Simulation Solaris64 Linux RedHat64
Momentum Engine, Local native 64-bit native 64-bit
Momentum Engine, Remote native 64-bit native 64-bit
Simulation
Momentum Visualization (and 3D 32-bit mode 32-bit mode

Layout Viewer)

Installing Advanced Design System on UNIX and Linux

Advanced Design System can be installed on UNIX and Linux systems using either the ADS installation DVD or by
downloading ADS installation images from the Agilent EEsof Knowledge Center website:

http://www.agilent.com/find/eesof-knowledgecenter
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For last-minute program and documentation information, refer to the Release Notes document on our website at:

http://www.agilent.com/find/eesof-docs
Choose Advanced Design System > Release Notes: 2008

Installation Overview

| Ohbtain codewords

|
Y

hMount installation OWD

J

Run setup program

|
¥

Install pragram files

|
Y

Configure user accounts

|
¥

Add codewords to license file
and start FLEXnet

WWill you use Yas

- 4

license bundles? ¥
Select bundle using the Agilent
Mo | License Preference Tool

¥

Launch Advanced
Design System

Quick Installation

Use this condensed installation procedure if you are experienced installing Agilent EEsof products; otherwise, refer to
Detailed Installation.
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If you installed an Early Access version of ADS 2008, you should uninstall it before installing this release.

1.
2.

10.

11.

12.

Log onto the system where you will install ADS.

If you are installing from a DVD and your system does not mount DVDs automatically, create a mount point,
typically: nkdir /dvd. Then mount the ADS DVD using the correct DVD for your platform. Examples of mount
commands:

mount -F hsfs -r /dev/dsk/cOt 6d0s0 /dvd (Solaris not running vold)

mount -t iso09660 /dev/dvd /dvd (Red Hat Linux)

If you logged in as root to mount the DVD, exit from being root before continuing the installation if you want to
avoid installing as root.

If you are installing from a downloaded image, download then untar the appropriate ADS installation image for
your platform from the Agilent EEsof Knowledge Center website:

http://www.agilent.com/find/eesof-knowledgecenter

Change directory to the Program DVD or to the path of the extracted tar files.

cd /dvd

(or use cd /cdron cdronD on Solaris running vold)

Start the Setup program using the following command:

./ SETUP. SH

When the Advanced Design System 2008 installation window appears, you can begin to set up the installation
and install ADS. Details about each window are available in Detailed Installation. When the installation is
complete, click Done to exit the installation program.

Unmount the installation DVD from the root directory:

unmount /dvd

(or use ej ect dvd9 on Solaris running vold)

Configure user accounts. See Configuring User Accounts.

Use the FLEXnet security codewords from Agilent EEsof to set up a license.lic file. See Setting Up Licenses.
Place the license.lic file in the licenses sub-directory of your ADS installation directory and start FLEXnet. See
Setting Up Licenses.

If you will be using license bundles, select a bundle using the Agilent License Preference Tool prior to running
ADS. This tool is described in Using the Agilent License Preference Tool.

Start ADS. See Running Advanced Design System.

Detailed Installation

Use the following steps for installing ADS on UNIX and Linux systems. If you have not done so, please review Before
You Begin. Also, if you installed an Early Access version of ADS 2008, you should uninstall it before installing this
release.

 Note

The installation program does not support cross-platform installations. Please be sure to use the correct
platform-specific installation disk for your system.
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To install ADS on UNIX and Linux systems:

1. Log onto the system using an account that has permissions to write to the disk to which you want to install.
2. If you are installing from a DVD, mount the ADS DVD making sure to use the correct DVD for your platform.
Mounting a DVD file system on a UNIX or Linux system requires root or super-user privileges on most systems.

 Note

If you are running Solaris and the DVD has been mounted by vold, you can skip to step 3. You can check if the
DVD is mounted by running the mount command without any arguments.

The typical mount point, or directory, for a DVD is /dvd. This may be different on your system. The mount point
directory must exist before you can mount the DVD. To create a /dvd directory, enter:

nkdir /dvd

To mount the Program DVD, run the command for your system. Here are examples:

mount -F hsfs -r /dev/dsk/c0t6d0s0 /dvd (Solaris not running vold)

nmount -t is09660 /dev/dvd /dvd (Linux)

Once the Program DVD is mounted, exit from being root before completing the rest of the installation procedure
if you do not want to install as root.

. If you are installing from a downloaded image, download then untar the appropriate ADS installation image for
your platform from the Agilent EEsof Knowledge Center website:

http://www.agilent.com/find/eesof-knowledgecenter

For example to untar the file on Linux:
tar xf ads330rday_linux_x86.tar

. Change directory to the Program DVD or to the path of the extracted tar files.
cd /dvd

 Note

If you are running Solaris, and the vold daemon is active, enter:
cd /cdronl cdromD

. Start the installation program using the following command:
./ SETUP. SH
Note that the Sun File Manager is not recommended to invoke SETUP.

) Note

If you are running Netscape, or another program that uses a lot of color resources, you should shut it down
before starting the Advanced Design System installation.

. At the Introduction window, click Next to read the License Agreement. This is a usage agreement and is not
related to the license codewords required to run the software.
. At the License Agreement window, after reviewing the agreement, choose:
e I accept the terms of the License Agreement, then click Next to continue with the setup.
e I do NOT accept the terms of the License Agreement to end the setup program.
. At the Choose Install Set window, choose
e Complete to install the basic ADS software, design guides, examples, and documentation. Refer to
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Installation Items. If you choose Complete, you can skip the next step.
e Custom to choose which ADS items you want to install. For a list of Custom Installation items, refer to
Installation Items.

i)

Note
While you choose here which ADS features you want to install, the ability to run them is determined by the
licenses you have purchased.

10.

11.

12.

13.

For a Custom installation, the next window lets you choose the items you want to install. You must choose to
install the ADS programs and tools option since it is the basic ADS software. You can always re-run the
installation program to install other items. Click an item name to see a description. Select the items you wish to
install and click Next to continue.
At the Choose Install Folder window, enter the full path to the directory where you would like ADS software to be
installed. If you specify a directory that does not already exist, the installation program will create it for you. The
default directory is /usr/local/ADS2008. Choose:

e Next to install to the default destination or

e Enter the full path or click Choose to browse to a different destination directory then click Next to install to

the specified folder.

At the Pre-Installation Summary, the installation directory you have selected is shown, along with the available
disk space on the disk partition that contains this directory. If you want to keep the installation directory shown,
click Install. If you want to change the installation directory, click Previous.
The Installing Advanced Design System 2008 window appears. When installation is finished, the Install Complete
window appears. Click Done to close the installation program.
Unmount the installation DVD:
cd /
unount /dvd9

Note
You must be in the root directory to unmount the DVD. If you are running Solaris and vold is active, enter
following command: ej ect dvd.

14.
15.

16.

17.

Configure user accounts. See Configuring User Accounts.

Use the FLEXnet security codewords from Agilent EEsof to create a license.lic file with the correct SERVER and
VENDOR line configurations. See Setting Up Licenses.

Place the license.lic file in the licenses sub-directory of your ADS installation directory and start FLEXnet to
enable your codewords. See Setting Up Licenses.

Start ADS. See Running Advanced Design System.

If you will be using license bundles, select a bundle using the Agilent License Preference tool prior to running

ADS. See Using the Agilent License Preference Tool.

Installation Items

A complete installation installs these items except the FLEXnet files, and requires approximately 4.5 GB of disk space.
For a custom installation, you can choose which items you want to install.

Item Description Size

ADS programs and tools This is the basic ADS software, minus | 1.8 GB

27



http://edocs.soco.agilent.com/display/ads2008/Setting+Up+Licenses+for+UNIX+and+Linux+Installation#SettingUpLicensesforUNIXandLinuxInstallation-1104336
http://edocs.soco.agilent.com/display/ads2008/Setting+Up+Licenses+for+UNIX+and+Linux+Installation#SettingUpLicensesforUNIXandLinuxInstallation-1104336
http://edocs.soco.agilent.com/display/ads2008/Using+Advanced+Design+System+after+UNIX+and+Linux+Installation#UsingAdvancedDesignSystemafterUNIXandLinuxInstallation-1107931
http://edocs.soco.agilent.com/display/ads2008/Setting+Up+Licenses+for+UNIX+and+Linux+Installation#SettingUpLicensesforUNIXandLinuxInstallation-1116668

Advanced Design System 2008

the following items

DesignGuides and Application Guides @ Special interactive tool kits and 630 MB
handbooks for various design types

FLEXnet Files FLEXnet licensing software 100 MB

Manuals & Help All manuals and help files. If this 900 MB

option is not selected, documentation
and help files will not be available

Examples All examples for Advanced Design 1.3GB
System

Configuring User Accounts

Configure the user accounts that will run ADS as follows:
C Shell

Add the following at the end of $HOME/.cshrc:

set env HPEESOF_DI R <install_directory>

setenv AG LEESOFD LI CENSE_FI LE <path_to_license_file>
Default: $HPEESOF_DIR/licenses/license.lic

set path = ( . $HPEESOF_DI R/ bin $path )

Bourne or Korn Shell

Add the following at the end of $HOME/.profile:

HPEESCOF_DI R=<install_directory>

AG LEESOFD_LI CENSE_FI LE=_<path_to_license_file>
Default: $HPEESOF_DIR/licenses/license.lic

PATH=. : $HPEESOF_DI R/ bi n: $PATH
export HPEESOF_DI R AG LEESCFD_LI CENSE_FI LE PATH
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 Note

If you are running Common Desktop Environment (CDE) or HP VUE, your user account may be using
$HOME/.dtprofile or $HOME/.vueprofile respectively to set up your user account instead of .cshrc or .profile.
The .dtprofile and .vueprofile files contain a line that can be uncommented to activate the use of .cshrc or
.profile. Please see your system administrator or CDE or VUE documentation for details.

Once the user accounts are configured, each user should log in and verify that the new environment variables are set.
Type the env command and check that HPEESOF_DIR and AGILEESOFD_LICENSE_FILE are set and that PATH contains

a path to the ADS bin subdirectory.

If you installed ADS as root, the ownership of directories and files will be set to user id 1313 and group id 22. To
change this, enter:

cd $HPEESOF_ DI R
chown -R root *
chgrp -R sys *

Setting the Display

If you plan to run ADS from a remote computer and you want the display to appear on your local machine, you will
need to set the DISPLAY environment variable:

setenv DI SPLAY <ny_host nane>: 0.0 (C-Shell)

DI SPLAY = <ny_host nane>: 0.0 _(Korn Shell, Bourne Shell)
export DI SPLAY

For a Sun Ray file server and diskless terminals using Solaris 8, you will need to set the DISPLAY environment
variable:

setenv DI SPLAY <server nane>$Di spl ay (C-Shell)
set DI SPLAY = <servername>3$Di spl ay (Korn Shell, Bourne Shell)
export DI SPLAY

For details on using the Sun Ray appliance, refer to the Sun website at:
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http://wwws.sun.com/sunray/index.html

Installing to Multiple Disk Partitions or Directories

If you do not have a single partition large enough to hold the entire ADS installation, you can spread the installation
across partitions using symbolic or soft links. The symbolic links are created before installation to redirect files to other
partitions.

For example, suppose you want to install ADS with most of the software installed in /opt/apps/eesof, but you want the
example projects to be installed to /disk2 due to lack of disk space in the /opt partition. Before starting the installation
program you would do the following:

1. Create the main installation directory:
cd /opt/apps
nmkdi r eesof
2. Create the directory that will hold the example files on / disk2:
cd /disk2
nkdi r ads_exanpl es
3. Create a link named examples in the main installation directory that points to the /disk2/ads_examples
directory:
cd /opt/ apps/ eesof
I'n -s /disk2/ ads_exanpl es exanpl es
4. Begin the installation process. When the examples are installed, the example projects will follow the
/opt/apps/eesof/examples link to /disk2/ads_examples.

Following is a list of the larger directory (not the complete list) names for ADS, along with approximate sizes. Any of
these directories can be re-directed to another disk partition as shown above for the examples directory. The sizes
shown are for a complete installation.

Directory Name Approximate Size
doc 900 MB)
examples 1.3 GB
DesignGuides 630 MB

Using Multiple ADS Versions

Use the following instructions to maintain and run more than one version of ADS (such as version 2006A and 2008).
Keep a separate $HOME directory for each version of ADS to help in structuring all the files and prevent problems that
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may arise if the configuration files are shared between multiple installations. The $HOME directory is where all your
projects are kept.

Setting the HOME Environment Variable

You need to specify the variable $HOME separately for each version of ADS that you want to run. You can set up two
directories from which you can run different scripts to launch the version of ADS you want.

Below are example scripts. Please change them to match your system.

Script for ADS 2006A

#!/ bi n/ ksh

#

# Script for starting ADS 2006A on UNI X and Li nux systens.
cd /users/jdoe/ ads2006a

HOVE=/ user s/ j doe/ ads2006a

HPEESOF_DI R=/ ut i | s/ eesof / ads2006a

PATH=$HPEESOF_DI F/ bi n: $PATH

export HOVE HPEESOF_DI R PATH

ads

Script for ADS 2008

#!/ bi n/ ksh
#

# Script for starting ADS 2008 on UNI X and Li nux systens.
cd /users/jdoe/ ads2008

HOMVE=/ user s/ j doe/ ads2008

HPEESOF_DI R=/ uti | s/ eesof / ads2008

PATH=$HPEESOF_DI R/ bi n: $PATH

export HOVE HPEESOF_DI R PATH

ads

Installing Connection Manager

If you will be using the Connection Manager product, you should be aware that it contains two parts: the Connection
Manager client, and the Connection Manager server.

The Connection Manager client is installed during the ADS installation. To run it, you must obtain the license
link_connect_mgr. Then, to use Connection Manager to communicate with instruments, you must install the
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Connection Manager server. The Connection Manager client and server installations are not related to a client-server
installation of ADS.

The Connection Manager server must be installed on a Windows PC. ADS 2008 does not include installation for
Connection Manger Server. To use Connection Manager Server with ADS 2008, install Connection Manger Server from
ADS 2006 Update 3 installation media. The Connection Manager server does not require a license. For instructions
about installing the Connection Manager server, see Installing Connection Manager Server. For general information
about Connection Manager, see the Connection Manager documentation.

) Note

Prior to ADS 2004A, when the Connection Manager Server was installed on a stand-alone Windows PC, ADS
had to be installed on the same PC. Starting with ADS 2004A, when you install Connection Manager server on
a stand-alone PC, it is no longer necessary to also install ADS on the same PC.

The Connection Manager client and server software must be from the same or compatible release. If you have
been using an older release of Connection Manager, then you install ADS 2008 on a client system, you also
must install a compatible release of the server software. Since the Connection Manager server was not
updated for ADS 2008, the compatible release for ADS 2008 is 2006 Update 3.

Setting Up Licenses for UNIX and Linux Installation

Use the following information to set up licenses for ADS on UNIX and Linux systems. After you install ADS using the
steps described in Installing Advanced Design System, you will need to set up the FLEXnet license manager and your
ADS license file (license.lic) before you can run ADS.

About FLEXnet

ADS uses Macrovision Corporation's Flexible License Manager (FLEXnet) software for all software security
configurations. When you run the ADS Setup program, the FLEXnet software is installed at <installation
folder>/licenses/bin where <installation folder> is the destination folder you specified when you ran Setup.

For Linux systems, you can use one of the following methods to run the FLEXnet licensing system on your PC:

e Install a USB FLEXid hardware key
e Read your LAN card's ethernet ID

For information on installing a FLEXid hardware key, see Installing a Hardware Key on Linux.
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For information about linking your LAN card's Ethernet ID to your ADS codewords, see Get Codewords for ADS 2008.

For details on using FLEXnet, refer to the Macrovision website at:

http://www.macrovision.com/

Choose Products > FLEXnet

Installing Licenses

You must request and install new license codewords for ADS 2008. To learn how to request codewords, see Get
Codewords for ADS 2008. To install and configure your new license file, complete the steps in the following sections.
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Save license file

Y

Edit license file

Y

Place license file

Y

Start license server

Y

Provide access to licenses

v

Will you use . Yes
bundled licenses?
No Y .
Select bundle using

Agilent License Preference Tool

Y

Launch Advanced Design System  |-m

 Note
If you are using the Mentor Graphics IFF interface for ADS, you need to install Mentor codewords in a separate
procedure. Obtain information from your Mentor Graphics representative.

Installing a Hardware Key on Linux

One way to run the FLEXnet licensing system on your PC is to install the FLEXid hardware key (also called a dongle)
on your computer's USB port. In a node-locked environment, it is installed on the local machine. In a floating license

environment, it is only required on the server machine.

To install the hardware key, see the FLEXid_README.pdf file located in the UNIX/dongle_sup directory on the ADS
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DVD. This directory also contains the files needed to install a USB hardware key. For the most up-to-date files, contact
your hardware key vendor.

© Note

Before you install the key, make a note of the hardware key ID number on the key. If you have not already
received your security codewords from Agilent EEsof, you will need to provide this number for your Codeword
Request Form.

For information about linking your LAN card's Ethernet ID to your ADS codewords, see Get Codewords for ADS 2008.

Save the License File

When you receive your codeword file from Agilent EEsof Business Support, it will be called license.lic. Save the
license.lic file using the same file name. Most codewords are distributed by e-mail.

Edit the License File

Edit your license.lic file to correct the SERVER line and add information to the VENDOR line. Refer to SERVER Line
Guidelines and VENDOR Line Guidelines for details. You can use the Agilent License Information Tool to check your
environment variable settings, display your license.lic file, and show your license and server status. For details, refer
to Using the Agilent License Information Tool.

© Note

Each line in the license.lic file must be a single continuous line with each field separated by a single space. You
may line wrap lines using the backslash ('\') character, but be very careful not to add a space after the
backslash. Otherwise, you can remove the backslash and make each INCREMENT line one continuous line.

Node-Locked File

The codeword file must follow the format shown in the following example. This example is from a node-locked file
where the quantity, displayed on the first line after the date, is typically "1":

SERVER unknown 81AAAAAA

VENDOR agi | eesof d

| NCREMENT ads_dat adi spl ay agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG=" 81AAAAAA : DXNLFPQ WZBCLQ2 AUJXJ2E | EKCKLI \
WFYQNVM DNJULYM LHYKAQC OM' HOSTI D=8laaaaaa START=11-nov-2007 \
S| G\="0169 4457 1B00 5266 852D 7813 5FB6 F38F 941A 1DOF E300 \
F868 5245 2627 CF7B 03B9 037F 9FOF 6BAE 32F6 321C'

| NCREMENT ads_| ayout agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG=" 81AAAAAA : KSGSOTJ D1JYAXW BOCLRMA 2YNB2HN \
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GFVU2LG FQLAQPJ UGW HOSTI D=8laaaaaa START=11-nov-2007 \
SI G\="0115 CEDE 58A8 A734 FF5C 8AC8 A3AC DAE6 FD7E E9D2 C002 \
EB4B OFF8 884C 61BE 84D7 ABOF A3E2 47EA EC4A3 A5E6G"

| NCREMENT ads_schematic agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG=" 81AAAAAA : NNWCSO WSVFW/Z JOXDHFS NRMARYN \
BHAHUW2 JVAJG J OEYHMLW ST" HOSTI D=8laaaaaa START=11-nov-2007 \
SI G\N="03E6 6359 6509 5297 45E2 6EB6 DBAF B148 04BF DE83 C502 \
E872 86AA 522C 9257 369B BE71 A3F5 4FDE 16E2 F13F"

| NCREMENT ndl _nul til ayer agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG=" 81AAAAAA : TS1OKRT El QGAUY DLYSXUY LUTGOHK \
ULCKL2R XYPNPHN EFKNVVD NGCWP" HOSTI D=8laaaaaa \
START=11- nov- 2007 S| G\="0333 DFD8 FD38 B049 9935 34CD A24B \
91DF 8BE5 3E17 3D03 3CAB 88C2 4239 D021 526B 45F1 E539 FAS55 \
B415 52C9"

| NCREMENT ndl _rfel ements agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG=" 81AAAAAA : WGPLOLS OVRAECK EYWZHVU DEAAKNJ \
F1GR2AB PXJEQM GIXMAJC OM' HOSTI D=8laaaaaa START=11-nov-2007 \
SI G\N="01DF 9875 C78C 73C9 30C8 29Cl 1C03 8629 6D57 E3C8 B303 \
7198 9355 4B6C 1D5D 08B3 7628 C27C FA84 BD76 64DB"

Floating-License File

The codeword file for a floating license is the same as the previous node-locked file example, with these exceptions:

e There is no HOSTID identifier in a floating license.
e The quantity can be any number, one or more, depending upon the number of licenses you own.

Below is a sample of a section of a floating-license file:

SERVER unknown 77542052

VENDOR agi | eesof d

| NCREMENT ads_dat adi spl ay agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG="2002002002 : DXNLFPQ WZBCLQ@ AUJXJ2E | EKCKLI
WFYQNVM DNJULYM LHYKAQC OM' START=11- namy- 2007 S| G\="03CC 8B82 \
5582 2A7F 7A5D B54F 05C8 ED12 3789 AFD6 DB0OO D838 8120 E013 \
DF09 F741 CDO5 4240 7B56 C012 822E"

| NCREMENT ads_schematic agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG="2002002002 : KSGSOTJ D1JYAKF UZJFEJI U2CRZDW\
FYANH W HKMNMAU FQLAQPJ UGW START=11- may- 2007 SI G\="023A 5C67 \
FFF1 FB55 24B7 0298 23AD 9480 0B84 2BCF 6A00 D20D FA99 C216 \
3189 OCOA 2CDA C208 EE6F C153 A672"

| NCREMENT ndl _adv_comm agi | eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG="2002002002 : LCSO WS VFW/ZJX WACYUNL AJUCIXZ \
DI UCIYZ DWEMCTE NHMLWST NW START=11- may- 2007 SI G\="023C B57A \
DF45 672E 5679 6CAF F705 48AC A4C9 4568 B600 356D AC99 EDDA \
E523 160F 9BEB D788 95FA D551 30F3"

| NCREMENT ndl _ant _array agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG="2002002002 : NGVUJ WQ UFPCUTQ UALAXBK TGR2ABP \
XJ2QGPB OGUAMGF VRWLQGN P" START=11- may- 2007 SI G\="0318 C721 \
85CE 15F3 99EB 79F8 9CDA 3E1A CA1B 6DA5 6B00 DE35 4002 077B \
32FB E942 2733 3557 1308 A52D Bl1FC'

| NCREMENT ndl _ant _cdra agi | eesofd 2.7 08-nov-2007 1\
VENDOR_STRI NG="2002002002 : EHABUQQ QVHABUC T2EDLTF SUKRXYA \
G AJGJU 1YMLHYK AQCOMXN' START=11-nmay-2007 Sl G\="01AD 66Al1 \
3949 C2CC E75B E2F2 7C64 6671 9774 1EE2 OF01 CDDE 20DB 672C \
8180 ADBE E62D 544B B6D2 E17E 30D2"
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SERVER Line Format

The SERVER line, by default, has the following format:

SERVER hostname hostid [port]
where:

hostname is the network name of the machine whose hostid appears in field 3 of the SERVER line. Use one of
the following commands to read the hostname for your system:

Operating System Command
Red Hat Linux /bin/hostname

Solaris /bin/hostname

hostid is the unique machine ID of the license server machine running Solaris. On Linux, it is either the unique
machine ID of the license server machine or the LAN card's Ethernet ID. Use one of the following commands to
read the hostid for your system:

Operating System Command
Red Hat Linux /sbin/ifconfig

Solaris /bin/hostid

port is an optional entry naming the TCP/IP port number that the license server will listen at for license requests.
An example port number is 27000.

SERVER Line Guidelines

e Your license file should contain an odd number of SERVER lines; for example, 1 or 3. If you have 3 SERVER lines,
the first SERVER is the primary license server and the other two are backup servers. All three SERVER lines must
use the same port number.

e You may only change the hosthame and the optional port humber fields.

¢ Adding or removing SERVER lines requires a new license.lic file.

e By default, Agilent EEsof sets hosthame to unknown. The SERVER line does not contain a port address. FLEXnet
software assigns a port address in the range of 27000 to 27009. The examples in this manual use a port address
of 27000, but your license file may differ. If you do not want to use the port address assigned by FLEXnet,
specify any other unused port number for your network.

) Note

Enter a specific port address on the SERVER line for improved license check-out performance. You may enter a
port address outside the range of 27000 to 27009, as long as the address is not used elsewhere. Also, set the
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environment variable AGILEESOFD_LICENSE_FILE as described in "Place License File".

e If the hostid is wrong, or changes for some reason, you will need to request a new license.lic file from Agilent
EEsof.
Here are examples of properly configured SERVER lines:
SERVER j oshua 2072EFE45 (default - FLEXnet assigns port address)
SERVER i sai ah 20472A3D3 27000 (optional - port address is specified)

VENDOR Line Format

The VENDOR line, by default, has the following format:
VENDOR daemon_name [daemon_path] [options_file_path] [port]

where:

daemon_name is the name of the vendor daemon.

daemon_path is an optional entry specifying a path to the vendor daemon.

options_file_path is an optional entry specifying a path to the FLEXnet options file.

port is an optional entry naming the daemon TCP/IP port number to use. A port number must be used when
connecting to the daemon through a firewall.

VENDOR Line Guidelines

e During installation of ADS, the vendor daemon is installed in the $HPEESOF_DIR/licenses/vendors and
$HPEESOF_DIR/licenses/bin directories.

e The daemon_name must be agileesofd.

e The path to the options file is intentionally left blank. If you want to use FLEXnet options, you must add a full
path to your option file. To learn about FLEXnet options, refer to the section "Using FLEXnet Options". If the file
does not exist and this option is not blank, a warning message will appear in the flex.log file.

e Here is an example of a properly configured VENDOR line including the daemon path, options file path, and port
number:

[ENDOR agi | eesofd /my_install _dir/licenses/vendors/agil eesofd \
/lmy_install _dir/licenses/agil eesofd. opt 27000

e For client systems connecting to a license server through an Internet firewall set up on Windows PC, the port
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number the vendor daemon uses must be specified. If the port is not specified, the default is chosen by the
operating system at run time. If this port number is specified, there may be a delay restarting the vendor
daemon until all clients have closed their connections to the vendor daemon.

© Note

Some clients may timeout before they can connect to a license server through a firewall set up on a Windows
PC. The default timeout period is 0.1 second. If you need a longer timeout period, you can set the environment
variable FLEXLM_TIMEOUT to a new value. Enter the value using microseconds. Agilent EEsof recommends
trying one second. For example:

FLEXLM_TIMEOUT=1000000

Depending on your network, you may need to adjust the period so it is long enough to allow connections
without slowing down simulations excessively.

INCREMENT Line Format

The INCREMENT lines must have the following format:

INCREMENT feature vendord ver exp num vendorstring hostid sign

where:

feature is the name of the feature licensed by this line.

vendord is the name of the vendor daemon that will manage this feature.

ver is the version of the feature licensed by this line.

exp is the expiration date of this license.

num is the number of licenses this line enables.

vendorstring is the CPU ID of the primary license server.

hostid is an optional field. If this field exists, it is the hostid of the machine that this license is node-locked to.
Only the machine whose hostid appears in this field may checkout this license.

sign is the encrypted codeword.
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INCREMENT Line Guidelines

¢ None of the fields on the INCREMENT lines are editable. Any change made to any of the fields on an INCREMENT
line will make that feature invalid. The only valid edit of an INCREMENT line is to add a backslash ('\") to line
wrap the line. Be careful not to add an extra space between fields when using a backslash to line wrap an
INCREMENT line.

e Here are two examples of valid INCREMENT lines.
Floating license example:

IINCREMENT ads_schematic agil eesofd 2.7 06-nov-2007 1 \

VENDOR_STRI NG="2003298463 : XMEBGCE PSUCKRT El QGAUY DLBVVHE \
| WNYES2 EWFTFGP AU2BKGR' START=09- may- 2007 SI G\N="0091 AE42 \
01AF 69F0 7D18 E9D3 F651 4EF0 S5EEA 6EB2 5D00 EOC2 F314 8CAE \
AB9C 3262 A18A OF3C 8178 EB11 F848"

Node-locked license example:

IINCREMENT ads_schematic agil eesofd 2.7 06-nov-2007 1 \

VENDOR_STRI NG="2007560205 : XMGEBGCE PSUCKRT El QGAUY DLBVVHE \
| WNYES2 EWFTFGP AU2BKGR' HOSTI D=77a8f 00d START=09- may- 2007 \
S| G\="01EB BB84 1441 154F 2E82 AFAA 3BDF 426A B6A9 3ACF 3A02 \
AE86 3414 510C 08BD 9C1D C69D D3D7 9CD6 579D 68D9"

The backslash used to line wrap these two INCREMENT line examples is prefaced by a space and contains a
carriage return immediately after it. The '\' character is the absolute last character of the line it is on.

Place License File

A copy of the license.lic file must be placed on all SERVER machine(s) listed in the license.lic file.

License Placement Guidelines

e The recommended location for the license.lic file is:
$HPEESOF_DIR/licenses/license.lic

¢ You might need root permission to copy the license.lic file into the ADS installation directory if ADS was installed
by a user logged in as root.

¢ You can choose to locate the license.lic file someplace else on the SERVER machine(s). If you choose to do this,
make sure that ADS users properly set AGILEESOFD_LICENSE_FILE.

e Make sure that the license.lic file has at least read permission for all users:
cd $HPEESOF DI R/ | i censes
chnod 555 license.lic
This command gives you read/executable permissions only.

¢ Place a copy of the $HPEESOF_DIR/license directory on all SERVER machines or custom install the FLEXnet
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license server on each machine.

Start the License Server (Imgrd)

Use the following procedure and guidelines to start the license server, Imgrd, on the SERVER machine.

 Important
Be sure to use the following guidelines to update all existing license servers with the latest version of the
FLEXnet software (e.g., Imgrd and Imutil). The software is installed with ADS 2008. Using older versions may
cause license-encryption errors, invalid hostid results, and unsupported feature errors.

Verify that all multiple and redundant servers are updated including any license administration scripts in use.
Run Imutil directly from the ADS 2008 installation location ($HPEESOF_DIR/licenses/bin) for information to
help modify the scripts.

You will need to stop, then restart, the license server to make these updates.

Guidelines for Starting Imgrd

e You only need to run Imgrd on the SERVER machine(s).

o If the SERVER machine(s) has ADS installed on it, you will find the FLEXnet license manager daemon (Imgrd) in
the $HPEESOF_DIR/licenses/bin directory. If the SERVER machine does not have ADS installed, you can copy the
$HPEESOF_DIR/licenses directory from the machine that has ADS installed.

e ADS installs version 11.4.1 of FLEXnet. Make sure you use the version 11.4.1 Imgrd and agileesofd supplied or a
newer version of Imgrd. You can determine the version of Imgrd and agileesofd by typing the following
commands:
cd $HPEESOF_DI R/ |i censes/ bin
lngrd -v
cd $HPEESOF_DI R/ | i censes/ vendor s
./l agileesofd -v

To start Imgrd:

Change the directory to where Imgrd resides on the SERVER machine and execute Imgrd. For example:

cd $HPEESOF_DI R/l i censes/ bin
Jlmgrd -c ../license.lic > ../flex.|og
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The login executing Imgrd must have full permissions to the licenses/bin directory and at least write permissions to
the directory specified for flex.log.

All error, warning and status messages will be redirected to the flex.log file. After starting Imgrd, wait approximately
30 seconds, then look at the contents of flex.log to see if there are any errors that need to be corrected.

To verify that the licenses are available:

Make sure that the flex.log file does not contain any errors, then run Imstat as follows:

cd $HPEESCF_DI R/l i censes/ bin
lmutil Imstat -a -¢c ../license.lic | nore

Or, you may launch the Agilent License Information Tool to do this. Refer to Using the Agilent License Information Tool
for more information.

If the licenses are available, you should see a listing similar to the following:

Imutil - Copyright \(C) 1989-2004 Macrovision Corporation. Al rights reserved

Fl exi bl e Li cense Manager status on Mon 9/22/2007 12: 42

Li cense server status: 27000@ oshua
Li cense files on joshua: ads2008/licenses/bin/../license.lic:
joshua: |icense server UP \(MASTER) v10.1

Vendor daenon status \(on joshual):

agi | eesofd: UP v10.1

Feat ure usage i nfo:

Users of ads_schematic: \(Total of 3 licenses avail able\)

Users of ads_layout: \(Total of 3 licenses avail able\)

Users of trans_iges: \(Total of 3 licenses avail able\)

Users of trans_dgsii: \(Total of 3 licenses avail able\)

Users of trans_iff: \(Total of 3 licenses avail able\)

Users of ads_lite: \(Total of 3 licenses avail able\)

Users of ads_datadisplay: \(Total of 3 licenses avail able\)

Users of simlinear: \(Total of 3 licenses avail able\)

Users of simharmonic: \(Total of 3 licenses avail abl e\)

Provide Access to Licenses

Before attempting to start ADS, you must configure each user's login environment to allow access to the licenses on
the SERVER machine(s). To do this you need to configure the environment variable named
AGILEESOFD_LICENSE_FILE in the user's .profile or .cshrc.

© Note

The AGILEESOFD_LICENSE_FILE environment variable will override any LM_LICENSE_FILE settings you might
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have set up. If AGILEESOFD_LICENSE_FILE is not set, LM_LICENSE_FILE will be used.

For example:
C Shell:

setenv AG LEESOFD_LI CENSE_FI LE $HPEESOF_DI R/ | i censes/license.lic

Bourne/Korn Shell:

AG LEESOFD_LI CENSE_FI LE=$HPEESCOF_DI R/l i censes/ | icense.lic
export AG LEESOFD LI CENSE FI LE

You can avoid the need to have a copy of the license.lic file directly on the machine running ADS by setting
AGILEESOFD_LICENSE_FILE as follows:

AGI LEESOFD_LI CENSE_FI LE=<por t >@SERVER_host nane>

where

port is the TCP port number from the SERVER line(s) of the license.lic file.

SERVER_hostname is the network name of a SERVER machine serving ADS licenses. This must be a hame that
the SERVER is known by on the network. You should be able to successfully ping this name from the machine
that will run ADS.

Or, if your license server is set up to search for an available port, your AGILEESOFD_LICENSE_FILE should read:

AG LEESCFD_LI CENSE_FI LE=@SERVER_host nane>

For example,

C Shell:

setenv AGQ LEESOFD LI CENSE _FI LE 27000@ oshua

OR
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setenv AQ LEESOFD LI CENSE _FI LE@ oshua

Bourne/Korn Shell:

AG LEESOFD_LI CENSE_FI LE=27000@ oshua
export AG LEESOFD_LI CENSE_FI LE

OR

AG LEESOFD_LI CENSE_FI LE=@ oshua

export AG LEESOFD_LI CENSE_FI LE

The syntax to access multiple license servers is as follows.

C Shell:

setenv AGQ LEESOFD LI CENSE _FI LE 27000@er ver 1: 27000@er ver 2: 27000@er ver 3

Bourne/Korn Shell:

export AG LEESOFD_LI CENSE_FI LE=27000@er ver 1: 27000@er ver 2: 27000@er ver 3

However, in this case, "server" should be replaced by the actual license server name or IP address, and the "27000"
may need to be changed to the actual port number on the license server. Note that the list of servers is separated by
colons (:). For details on running FLEXnet-licensed products from multiple vendors refer to Merging Multiple Vendor
Licenses.

Using a UNIX/Linux-to-PC Floating License

A Windows PC system can access the UNIX or Linux license server's license.lic file in either of two ways:

e By copying the license.lic file from the UNIX/Linux license server to the Windows PC's $HPEESOF_DIR/licenses
folder
e By setting the AGILEESOFD_LICENSE_FILE variable on the Windows PC to point to the UNIX/Linux license server
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as follows:

set AQ LEESCOFD LI CENSE FI LE=<port >@khost >

For example:

set AG LEESOFD LI CENSE_FI LE=27000@ oshua

where

27000 is the port number on the SERVER line in the license.lic file on the UNIX/Linux license server

joshua is the hostname of the UNIX/Linux license server

Conversely, the license server can be a Windows PC with a floating license locked to a LAN card or dongle hardware
key and the UNIX/Linux computer can be set to point to it in the same way by using its host name or IP address.

Automating FLEXnet License Manager Startup

You can automate the FLEXnet startup so that Imgrd is started automatically each time the license server machine is
rebooted by adding the following three lines for a startup routine to the appropriate rc file for your operating system:

/ads/licenses/bin/Imgrd -c /ads/licenses/license.lic > /ads/l|licenses/flex.log &
echo "Starting Agilent EEsof FLEXnet |icense daenon...... "
/usr/bin/sleep 5

 Note

Be sure to change all references to /ads to the actual path of your Agilent EEsof software installation directory.

Following are instructions for the supported operating systems:

1. Change to the appropriate directory:
/etc/rc.d/init.d (Linux)
/etc/rc3.d (Solaris)

2. Create a file in this directory named Sagileesofd.

© Note

The S is capitalized. All other letters are in lower-case.

3. Place the FLEXnet startup routine (shown above) into this file.
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4. Set the permissions for this file as follows:
chnod 755 Sagil eesofd
chown root Sagil eesofd
chgrp sys Sagil eesofd

5. For Linux license servers, create the following soft links:
In -s /etc/rc.d/init.d/ Sagil eesofd rc3.d/ S99Sagi | eesof d
In -s /etc/rc.d/init.d/ Sagil eesofd rc4.d/ S99Sagi | eesofd
In -s /etc/rc.d/init.d/ Sagil eesofd rc5.d/ S99Sagi | eesofd

Selecting a License Bundle

This step is necessary only if you are using license bundles.

If you have been using license packages in previous versions, you should be aware that packages were replaced by
license bundles in ADS 2003A. Bundles are an improvement over packages by giving you more control over which
license bundles are used during an ADS session.

You must select a bundle when starting ADS to ensure a license bundle is being used. The Agilent License Preference
Tool is available to help you make a selection. To learn how to select bundles using the preference tool, see Using the
Agilent License Preference Tool.

Special Licensing Needs

Use the following information to accommodate any special licensing needs you may have. For details on using
FLEXnet, refer to the Macrovision website at:

http://www.macrovision.com/
Choose Products > FLEXnet

Using FLEXnet Options

An options file enables the license administrator to control the security parameters of FLEXnet. Specifically the license
administrator can:

¢ Allow the use of features based on user, hostname or display name.
e Deny the user of features based on user, hostname or display name.
e Reserve licenses based on user, hostname or display name.
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e Control the amount of information logged about license usage.

Creating an Options File

Use the desired options listed below to create the options file using any text editor. Ideally, you should keep the
options file in the same directory as your license.lic file. Also, add the pathname to the options file in the license.lic file
as the fourth field on the VENDOR line for agileesofd as shown in the following example. (Remember to use the
backslash ('\') character if the file contains wrapped lines.)

VENDOR agi | eesof d /ads2008/ | i censes/vendors/ agi |l eesofd \
/ ads2008/ | i censes/ agi | eesof d. opt

You can include comments in your options file by starting each comment with a pound sign "#". Everything in the
options file is case-sensitive. Be sure that user names and feature names, for example, are entered correctly. The
available options are:

e EXCLUDE
Deny a user access to a feature.
e EXCLUDEALL
Deny a user access to all feature served by this vendor daemon.
e GROUP
Define a group of users for use with any options.
e INCLUDE
Allow a user to use a feature.
e INCLUDEALL
Allow a user to use all features served by this vendor daemon.
e NOLOG
Turn off logging certain items.
e REPORTLOG
Specify that a logfile be written suitable for use by the FLEXadmin End-User Administration Tool.
e RESERVE
Reserve licenses for an individual user or groups of users.
e TIMEOUT
Works only for specified simulator and library licenses.
e TIMEOUTALL
Works for all simulator and library licenses.

Use the following steps to create and use an options file. Details about each step located in Installing Licenses:

1. Create an options file with your required options.
2. Modify your license.lic file so that the VENDOR or DAEMON line points to this option file as shown in this
example:

[ENDOR agi | eesof d /ads2008/ | i censes/vendor s/ agi | eesofd \
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/lads2008/ | i censes/ agi | eesof d. opt

3. Start up your license server (Imgrd) that is pointing to your license file. You must stop it first if it is running. It's
important that a message is displayed or recorded in the FLEXnet log verifying the license manager is using the

options file. The following example shows that the license manager is using the agileesofd.opt file containing the
TIMEOUTALL option set to 900 seconds:

17:35: 14 \(agil eesofd\) Using options file: "/ads2008/1icenses/ agil eesofd. opt"
17:35:15 \ (agi |l eesof d\) ALL FEATURES: | NACTIVITY TIMEQUT set to 900 seconds

4. Set AGILEESOFD_LICENSE_FILE to point to your license server.
5. Run ADS.

Specifying the TIMEOUT Option

You can set a custom time-out period for simulator and library licenses using the TIMEOUT or TIMEOUTALL options. If
you do not specify a time-out value in your options file or do not have an options file, a default two-hour limit is used.
These time-out options apply to those application features that have explicitly implemented time-out via the heartbeat
function. This includes licenses for the Analog/RF and Signal Processor simulators and for libraries, and do not affect
licenses for the design environment and data display. The time-out option sets the amount of time a feature may
remain idle before its license is released and reclaimed by the vendor daemon. The TIMEOUT option enables you to
identify specific licenses, and the TIMEOUTALL affects all licenses (simulators and libraries).

To use TIMEOUT, add an entry for each feature to the options file using the following format:

Tl MEQUT feature_name seconds
where:
feature_name is name of the feature.

seconds is the number of seconds before inactive license is reclaimed. The minimum value is 900 seconds (15
minutes). If you specify a time-out value smaller than the minimum, the minimum is used.

The option TIMEOUTALL works just like TIMEOUT, but applies to all features.

TI MEOUTALL seconds

Here are example entries you can include in your options file:
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To set a time-out for the harmonic balance simulator to one hour (3600 seconds):
TI MEOUT si m harnoni c 3600
To set time-outs for multiple simulators to different periods:

TI MEQUT simlinear 900
TI MEQUT si m harnoni c 3600
TI MEQUT si m convol uti on 3600

To set a time-out for all simulators and libraries to one hour (3600 seconds):

TI MEQUTALL 3600

Updating the License File

If you have been running FLEXnet and receive updated codewords from Agilent EEsof, you can add the new licenses to
the FLEXnet environment as follows:

1. Replace the existing license.lic files on the license servers and clients with the new license.lic file.

2. On the primary server, run I nutil | nreread. This causes the Imgrd on the primary server to re-read the
license.lic file and update all of the other Imgrd processes on the network.

3. After you have done this, you can runlnmutil | nstat -a to verify that the license servers have received the
new license information.
If this does not work, you may need to stop all of the Imgrd processes on your network and then restart them as

described in the section "Installing Licenses".

Merging Multiple Vendor Licenses

When you are running FLEXnet-licensed products from multiple vendors, you have three ways to prevent licensing
conflicts during installation:

e Multiple license server nodes; each running one Imgrd and one license file
e One license server node running one Imgrd and one license file
¢ One license server node running multiple Imgrds and multiple license files

Each Imgrd can only read a single license file. With the first option you will have more license servers to monitor. With
the third option you have only one server but multiple Imgrds to administer.
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Your product's license file(s) define the license server(s) by hostname and hostid in the SERVER line(s) in the license
file.

o If the license files for two or more products contain identical hostids on the SERVER line(s), then these files can
be combined.

o If the license files for two products contain different hostids on a SERVER line, then the license servers for those
products will be running on different nodes and the license files cannot be combined.

If you have two or more products whose license servers run on the same node (as specified by the SERVER lines in
the license files), you may be able to combine the license files into a single license file.

o If the SERVER lines in those files have identical hostids, then you can combine the files into a single file.
o If the SERVER lines have different hostids, then you must keep the license files separate.

More precisely, you can combine two license files under the following conditions:

1. The number of SERVER lines in each file is the same.
2. The hostid field of each SERVER line in one file exactly matches the hostid field of each SERVER line in the other
file.

Some possible reasons license files may not be compatible are:

e License files are set up to run on different server nodes, so hostids are different.

¢ One file is set up for single server (has only one SERVER line), the other is set up for redundant servers (has
multiple SERVER lines).

¢ One vendor uses a custom hostid algorithm, so the hostids on the SERVER lines are different even though the
files are for the same machine.

If your license files are compatible as described above, then you can combine license files and run a single Imgrd, as
described in "Combining License Files from Multiple Vendors". If the license files are not compatible, then you must
keep the license files separate and run separate copies of Imgrd for each license file, as described in the section,

"Using Separate License Files on the Same Server Node".

 Important
There is virtually no performance or system-load penalty for running separate Imgrd processes.

Combining License Files from Multiple Vendors

If your license files are compatible, you can combine them using any text editor. To combine license files, merge all of
the compatible license files into one file, then edit out the extra SERVER lines so that only one set of SERVER lines
remains. Write out this data, and you have your combined license file.

If you combine license files from multiple vendors, it is a good idea to keep a copy of the combined license file in each

50



Advanced Design System 2008

vendor's default license file location. This way, your users can avoid having to set AGILEESOFD_LICENSE_FILE,
because each package finds its license information in the default place. On UNIX and Linux, you can do this with a
symbolic link from each default location to the location of the combined license file.

FLEXnet Version Component Compatibility

When you combine license files for two different FLEXnet-licensed products, the products may not use the same
version of FLEXnet. FLEXnet is designed to handle this situation. There are two basic compatibility rules for FLEXnet:

1. A newer Imgrd can be used with an older vendor daemon, but a newer vendor daemon might not work properly
with an older Imgrd.

2. A newer vendor daemon (or Imgrd ) can be used with an older client program, but a newer client program might
not work properly with an older vendor daemon.

From these two compatibility rules come the simple rules for selecting which version of administration tools to use:

1. Always use the newest version of Imgrd and the newest version of each vendor daemon.
2. Use the newest FLEXnet utilities.

For specific application programs, you can use either the new or the old version (with the assumption that the vendor
daemon for that application is at least as new as the application).

Using Separate License Files on the Same Server Node

You must run a separate copy of Imgrd for each license file. When you run multiple copies of Imgrd, there are two
details to remember:

1. The port number on the SERVER line of each license file must be unique. You can use a standard text editor to
change the port number in each license file so that they are all different.

2. You must make sure that you are using a compatible version of Imgrd when you start it up for a particular
license file. This can be done by using an explicit path to Imgrd.

When running client programs (such as a licensed application), you can set the AGILEESOFD_LICENSE_FILE
environment variable to point to multiple license files. For example, you may have a license file from vendor ABC and
a license file from vendor XYZ with incompatible servers. You can place the license file from vendor ABC into:

/user/flexnet/abc.lic

and the license file from vendor XYZ into:
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[user/flexnet/xyz.lic

then set the AGILEESOFD_LICENSE_FILE environment variable to point to both of them. The syntax is as follows:

AG LEESOFD LI CENSE_FI LE=27000@er ver 1; 27000@er ver 2; 27000@er ver 3

Note that each path is separated with a semi-colon.

AGILEESOFD_LICENSE_FILE can point to only one license file for FLEXIm v1.x applications.

Redundant License Servers

You can set up a redundant or backup license server(s), in case a primary server is unavailable. If your license.lic file
has the maximum number of SERVER lines (three), you have a redundant license server configuration. The license
setup is identical to a single SERVER configuration, with the exception that no licenses will be available until a majority
of the license servers are running. That is, if you have three SERVER lines, at least two must be up and running before
any licenses will be available for checkout. Be sure that the FLEXnet software is loaded and running on each server.

) Note

If you have more than one SERVER line in the license.lic file, you must start Imgrd on all the SERVER machines
to enable the licenses.

Controlling License Path Settings

The Imutil utility provides the Impath function which allows direct control over FLEXnet license path settings. You can
use Impath to add to, override, or get the current license path set in the registry. This enables you to change or view
path settings without locating individual settings in the Windows registry on the PC or in the FLEXnet registry
(.flexlmrc) on UNIX and Linux.

The Imutil utility is located in $HPEESOF_DIR/licenses/bin. This location must be in your PATH, or use the following
command before running the utility:

cd $HPEESOF_DI R/l i censes/ bin

The usage for this function is:
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I mutil | npath {-status | -add | -override} {vendor_name | all} license_path_list
where
-status displays the current license path settings.

-add appends license_path_list to the front of the current license-path settings or creates the list of license-path
settings, if it doesn't exist, initializing it to license_path_list. Duplicates are discarded.

-override overrides the existing list of license-path settings with the contents of
license_path_list. If license_path_list is the null string, "", the specified list is deleted. For example:

e |nutil Inpath -override agil eesofd ""

Deletes the value of AGILEESOFD_LICENSE_FILE from the registry.
e |putil |npath -override vendor2 ""

Deletes the value of VENDOR2_LICENSE_FILE from the registry.
e |nutil Inpath -override all

Deletes the value of LM_LICENSE_FILE from the registry.

vendor is a string naming a particular vendor daemon name. Affects the value of vendor _LICENSE_FILE. For
example, use agi | eesof d to affect AGILEESOFD_LICENSE_FILE.

all refers to all vendor daemons. Affects the value of only LM_LICENSE_FILE.

license_path_list is the new path setting(s). On UNIX and Linux, this is a colon-separated list, and on Windows it
is a semi-colon-separated list. If license_path_list is the null string, "", then the list is deleted for the specified
vendor. Though you can enter specific license file names, you gain flexibility by entering only a path without a
file name. This will include all *.lic files in the same location.

© Note

Environment variable settings (set in your shell) always override these registry settings.

Checking the Status

Before you change license path settings, Agilent recommends that you display the current settings. To display the
settings, enter the following commands:

Imutil | npath -status
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The following example status listing is from UNIX and is similar to Linux and Windows listings:

Imutil - Copyright \(C) 1989-2004 by Macrovision Corporation. Al rights reserved.
Known Vendor s:

) Note

Where a path is set to a directory, each of the *.lic files are listed separately.

Changing License Path Settings

When adding or overriding path settings, Impath sets the FLEXnet entry in the Windows registry on the PC, or changes
the file $HOME/.fleximrc on UNIX and Linux. Here are examples of how license settings may appear in each registry:
UNIX and Linux

AG LEESCOFD LI CENSE_FI LE = /ads2003a/licenses:/ads2008/licenses

Windows

Registry location:
My Comput er\ HKEY_LOCAL_MACHI NE\ Sof t war e\ Agi | ent\ ADS2008

Registry license path setting:
AG LEESOFD LI CENSE_FI LE REG Sz C:\ ADS2008\ | i censes

To change license path settings, enter the appropriate command in a Command Prompt on Windows, or a terminal
window on UNIX and Linux. You can adapt the following examples which change path settings for
AGILEESOFD_LICENSE_FILE:

e To add path settings on UNIX and Linux:

Imutil Inpath -add agil eesofd: <new_|lic_pathl>:<new_|ic_path2>
e To add path settings on Windows:

Imutil Inpath -add agileesofd C \<new |ic_pathl>; C\<new |ic_path2>
e To replace the current path settings on UNIX and Linux:

Imutil I npath -override agil eesofd <new_|ic_path>
e To replace the current path settings on Windows:

Imutil Inpath -override agileesofd C\<new_ |lic_path>
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Manually Setting the License Bundle Preference

If you are using license bundles, you are aware that you must select a bundle prior to running ADS. Typically, bundles
are selected by using the Agilent License Preference Tool. This tool is discussed in Using the Agilent License Preference
Tool. However, system administrators and advanced users can manually configure environment variables when they
need more bundle selection flexibility. Proper configuration using these environment variables control which licenses
are used, and the systems using them.

The two environment variables that control bundle selection are:

e AGILEESOFD_LICPREF<hostname> controls bundle selection specifically for the system identified by
<hostname>.

e AGILEESOFD_LICPREF controls bundle selection for all systems on a network with access to the license server.

ADS looks for these variables in the following locations in the order given here:

Shell environment
<project_directory>/hpeesof.cfg
$HOME/hpeesof/config/hpeesof.cfg
$HPEESOF_DIR/custom/config/hpeesof.cfg
$HPEESOF_DIR/config/hpeesof.cfg

ADS first looks for AGILEESOFD_LICPREF<hostname> in each of these locations. If ADS cannot find a value for
AGILEESOFD_LICPREF<hostname>, then ADS looks for AGILEESOFD_LICPREF. If AGILEESOFD_LICPREF is not found,
no bundle is selected.

Examples

e Joe Smith wants to use the pl_desenv bundle when he runs ADS on the system with the hostname alpha. To set
this up, Joe should add

AG LEESOFD LI CPREF_ALPHA=pl _desenv
to the configuration file

$HOME/hpeesof/config/hpeesof.cfg
where $HOME is Joe's home directory

¢ A system administrator wants to configure a system to use the pl_ui bundle when anyone runs ADS on the
system named beta, and to use the ltp_mmic bundle when ADS is run on other systems. To set this up, the
administrator should add
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AGI LEESOFD_LI CPREF_BETA=pl _ui and
AGI LEESOFD_LI CPREF=I t p_nmi ¢

to the configuration file

$HPEESOF_DIR/custom/config/hpeesof.cfg

Accessing Licenses through a Firewall

There may be situations where it is necessary to check out FLEXnet licenses through a firewall (or router). This may
occur when a license server is behind a company firewall and other sites or companies need to check out licenses.

Assuming your license agreement allows you to serve licenses in this manner, you can enable license checkout
through a firewall by configuring your firewall to allow TCP communication through the TCP ports used by the license
manager daemon (Imgrd) and any vendor daemons you will run.

For example, assume you have a license server serving EEsof EDA licenses and your license.lic file contains the
following lines:

SERVER nyserver 00809AC7123F8

VENDOR agi | eesof d / apps/ fl exnet/vendor s/ agi | eesofd
VENDOR agi | eesof [apps/flexnet/vendors/agil eesof
DAEMON hpeesofd /apps/fl exnet/vendors/ hpeesof d

To set up your firewall to allow TCP access to the license server, you must specify a TCP port number for Imgrd on the
SERVER line and for each vendor daemon on the VENDOR or DAEMON lines. For example:

SERVER nyserver 00809AC7123F8 27005

VENDOR agi | eesof d / apps/ fl exnet/vendors/ agi | eesofd port=1705
VENDOR agi | eesof /apps/flexnet/vendors/agil eesof port=1706
DAEMON hpeesofd /apps/fl exnet/vendors/ hpeesofd port=1707

 Note

After specifying TCP ports in your license.lic file, you must stop and restart your license server.

Next, configure your firewall or router to allow TCP communication through the TCP ports you specified in your
license.lic file. In the example above this would be ports 27005, 1705, 1706, and 1707.

Finally, clients must set the AGILEESOFD_LICENSE_FILE environment variable to the port number assigned to the
license server. Using the example above, the setting would be:
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AG LEESOFD_LI CENSE_FI LE=27005@ryser ver

Once this has been done, clients outside of the firewall will be able to access licenses from your server.

i)

Note

Some clients may timeout before they can connect to a license server through a firewall set up on a Windows
PC. The default timeout period is 0.1 second. If you need a longer timeout period, you can set the environment
variable FLEXLM_TIMEOUT to a new value. Enter the value using microseconds. Agilent EEsof recommends
trying one second. For example:

FLEXLM_TIMEOUT=1000000

Depending on your network, you may need to adjust the period so it is long enough to allow connections
without slowing down simulations excessively.

Managing Multiple ADS Versions

This section discusses how to manage the licenses for multiple versions of ADS.

Backward Compatibility of Codewords

The following table lists ADS releases with details of their license management:

Release Name License File Daemon Name FLEX Version License Default License
Version Environment File Location
Variable
ADS 1.5 1.5 hpeesofd FLEXIm 7.0g LM_LICENSE_FILE ] $HPEESOF_DIR/lic
ADS 2001 1.7 HPEESOFD_LICEN$E_FILE

Enses/lic
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ADS 2002 1.9 agileesof FLEXIm 7.2h CRO AGILEESOF_LICENISEHPEIHSOF_DIR/HC Enses/
ADS 2002C 2.1
ADS 2003A/C 2.3 agileesofd FLEXIm 8.2a CRO | AGILEESOFD_LICENSE_FILE
ADS 2004A 2.34 FLEXIm 9.2a CRO
ADS 2005A 2.35 FLEXnet 10.1.3
CRO
ADS 2006 2.6 FLEXnet 10.8
CRO
ADS 2008 2.7 FLEXnet 11.4.1

The following table shows the codeword compatibility between various ADS releases. Note that codeword compatibility
also depends on the whether the codeword was available in that release.

Codewords Will Work With This Release
From This
Release ADS 2008 | ADS 2006 | ADS 2005A | ADS 2004A | ADS 2003C | ADS 2003A | ADS 2002C | ADS 2002
ADS 2008 | X X X
ADS 2006 X X X
ADS 2005A X X X X
ADS 2004A X X X
ADS 2003C X X
ADS 2003A X X
ADS 2002C X X
ADS 2002 X X

Combining ADS Codewords with Other Agilent EEsof EDA Codewords

For ADS 2008, the vendor daemon agileesofd is used. This is the same vendor daemon that was used for ADS 2003A,
2003C, 2004A, 2005A, 2006A, 2006 Update, and 2008. If you want to serve ADS 2008 licenses and earlier from the
same server, you need to have the latest version of Imgrd, v9.2a, and two or three DAEMON lines in your license file,
depending on how many versions you want to support. The ADS daemon names available are:

agileesofd - for ADS 2003A, 2003C, 2004A, 2005A, 2006A, 2006 Update, 2008
agileesof - for ADS 2002 and 2002C
hpeesofd - up to and including ADS 2001
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For example, the license file would include:

SERVER hpnnens 77a588a7 1700

VENDOR agi | eesof d /ads2008/1i censes/ vendor s/ agi | eesof d
VENDOR agi | eesof /ads2002C/ |i censes/ vendor s/ agi | eesof
DAEMON hpeesof d /ads2001/1i censes/vendor s/ hpeesofd

You would then add the INCREMENT lines for the different products to the file.

The name and extension of the license file are arbitrary (i.e., license.dat, license.lic or adslicenses.txt). By default, all
ADS versions up to and including ADS 2001 look for a file named license.dat and all ADS versions from ADS 2002 to
ADS 200A look for a file named license.lic. You can use one of these names, or some other name you prefer.
Whatever name you choose to use, make sure you set the environment variables to point to your license file.

The supported environment variables are:

AGILEESOFD_LICENSE_FILE for ADS 2003A through 2008
AGILEESOF_LICENSE_FILE for ADS 2002 and 2002C
HPEESOFD_LICENSE_FILE for ADS 2001
LM_LICENSE_FILE for ADS 1.5 and earlier

For example, if the combined codeword file is named adslicenses.txt and you want to build a license file that contains
ADS 2008, ADS 2003C, ADS 2002C, ADS 2001, and IC-CAP 2001 codewords, then:

Each

ADS 2003C and 2008 will use:
AGILEESOFD_LICENSE_FILE=/licenses/adslicenses.txt
ADS 2002 and 2002C will use:
AGILEESOF_LICENSE_FILE=/licenses/adslicenses.txt
ADS 2001 will use:
HPEESOFD_LICENSE_FILE=/licenses/adslicenses.txt
IC-CAP 2001 will use:
LM_LICENSE_FILE=/licenses/adslicenses.txt

version of ADS uses a certain search order to look for the environment variable:

ADS 2003C through 2008 will first look for the environment variable named AGILEESOFD_LICENSE_FILE. If
AGILEESOFD_LICENSE_FILE and LM_LICENSE_FILE are both defined, ADS 2003C through 2008 will use
AGILEESOFD_LICENSE_FILE and ignore LM_LICENSE_FILE. If AGILEESOFD_LICENSE_FILE is not defined, then
ADS 2003C through 2008 will default to LM_LICENSE_FILE.

ADS 2002 and 2002C will first look for the environment variable named AGILEESOF _LICENSE_FILE. If
AGILEESOF_LICENSE_FILE and LM_LICENSE_FILE are both defined, ADS 2002 and 2002C will use
AGILEESOF_LICENSE_FILE and ignore LM_LICENSE_FILE. If AGILEESOF_LICENSE_FILE is not defined, then ADS
2002 and 2002C will default to LM_LICENSE_FILE.

ADS 2001 will first look for the environment variable named HPEESOFD_LICENSE_FILE. If
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HPEESOFD_LICENSE_FILE and LM_LICENSE_FILE are both defined, ADS 2001 will use HPEESOFD_LICENSE_FILE
and ignore LM_LICENSE_FILE. If HPEESOFD_LICENSE_FILE is not defined, then ADS 2001 will default to
LM_LICENSE_FILE.

e All previous ADS versions, up to and including ADS 1.5 will use LM_LICENSE_FILE.

Even though all versions of ADS will default to LM_LICENSE_FILE if that is the only environment variable that exists, it
is recommended that you use the supported environment variables listed above.

Example of a Merged License File

SERVER sol arone 80FB214D 1700

DAEMON hpeesofd /hfs/dl/local/licenses/hpeesofd
VENDOR agi | eesof /hfs/d1/1ocal/licenses/agil eesof
VENDOR agi | eesofd /hfs/dl/1ocal /licenses/ agil eesofd

#

# ADS 2001 codewords

#

| NCREMENT Adapt _conp hpeesofd 1.5 03-nov-2002 5 EC7A98E3FB4AC8771142 \
VENDOR_STRI NG=s=80FB214D

| NCREMENT Ad_da_appkit hpeesofd 1.5 03-nov-2002 5 \
1CCA189368AF358196C4 VENDOR _STRI NG=s=80FB214D

| NCREMENT Ampsa_appkit hpeesofd 1.5 03-nov-2002 5 \
0CBAB813D8101E34EB55 VENDOR_STRI NG=s=80FB214D

#

# | G- CAP 2001 codewords

#

| NCREMENT a_si _tft agileesof 6.0 29-oct-2001 1 DOA4535DE290 \
VENDCOR_STRI NG=s=80FB214D

| NCREMENT ac_driver agileesof 6.0 29-oct-2001 1 1A9EE36873A0 \
VENDOR_STRI NG=s=80FB214D

| NCREMENT anal ysi s agil eesof 6.0 29-oct-2001 1 025C2B939BD5 \
VENDOR_STRI NG=s=80FB214D

#

# ADS 2002C Codewor ds

#

| NCREMENT ads_dat adi spl ay agil eesof 2.0 30-jun-2002 1 \
VENDOR_STRI NG=80FB214D HOSTI D=80f b214d SI G\="008E 5A70 FECF \
8BEF 9B3A 8A67 7375 0A51 0940 A264 6B00 C335 666B 03E2 DSE7 \
99A8 AOF9 9007 2AC4 EF7D E101"

| NCREMENT ads_dat adi spl ay agil eesof 2.0 30-jun-2002 1 \
VENDOR_STRI NG=80FB214D S| G\N="01CB 4272 B241 5A67 A4C8 CADB \
A080 FFB2 7796 6C29 EC02 C3A9 FDBA BE47 COCO F027 5552 947F \
64CC 06BA 2201"

| NCREMENT ads_drc agi |l eesof 2.0 30-jun-2002 1 VENDOR STRI NG=80FB214D \
HOSTI D=80f b214d SI G\N="0138 3E48 7191 3703 8FFB 2614 067B 2A7E \
203F 4FOC C900 79FE F186 9B1E 2B10 3B3D D650 2204 18CF 00C9 \

3E3A"
#
#ADS2003C codewor ds
#

| NCREMENT ads_dat adi spl ay agil eesofd 2.3 07-jul -2003 1 \
VENDOR_STRI NG="00047518D858 : OR2GAZUD WSGSONJ 2HNECZL 12WKCKE \
LRXYGSO MAYFKGP AKBPONX LOYSO' HOSTI D=00047518d858 S| G\N="0246 \
771A BBA2 AOD4 B29E 7371 6FF7 F3D9 161A 1204 EE00 2E92 8ACO \
1AF7 FAF9 5B2C B017 23F7 91E8 BF97 B9AD'

| NCREMENT ads_drc agil eesofd 2.3 07-jul -2003 1 \
VENDOR_STRI NG="00047518D858 : QEGHABO KEYWIHV 1HElI WAD JFAVQRA \
UIXJ2EW KYARWEQ GY" HOSTI D=00047518d858 S| G\="02EC 9EA3 EE62 \
BDBC 9793 019D 0551 FD3E 20DD DOC1 D301 DA95 9F79 16A8 5E11 \
1B81 E7CC 90F8 68A0 E116 8FOB"

| NCREMENT ads_encoder agil eesofd 2.3 07-jul-2003 1 \
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VENDOR_STRI NG="00047518D858 : GONJAZX FHGGNAP BWOG AH PBKVEYK \
UCKGULO YSCRGAZ UDWBGS" HOSTI D=00047518d858 S| G\N="027B 178E \
2893 8446 A5C4 0990 830E CC2C F215 528B 6401 9B93 9540 A54C \
B85A A68E 0049 200F 1685 96D1 FD7F"
#
# ADS2008 codewor ds
#
| NCREMENT ads_dat adi spl ay agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG=" 81AAAAAA : DXNLFPQ WZBCLQ2 AUJIXJ2E | EKCKLI \
WEFYQNVM DNJULYM LHYKAQC OM' HOSTI D=8laaaaaa START=11- nov-2007 \
S| G\="0169 4457 1B00 5266 852D 7813 5FB6 F38F 941A 1DOF E300 \
F868 5245 2627 CF7B 03B9 037F 9FOF 6BAE 32F6 321C'
| NCREMENT ads_| ayout agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG=" 81AAAAAA : KSGSOTJ D1JYAXW BOCLRMN 2YNB2HN \
GFVU2LG FQLAQPJ UGW HOSTI D=8laaaaaa START=11-nov-2007 \
SI G\="0115 CEDE 58A8 A734 FF5C 8AC8 A3AC DAE6 FD7E E9D2 C002 \
EB4B OFF8 884C 61BE 84D7 ABOF A3E2 47EA ECA3 ASE6"
| NCREMENT ads_schematic agil eesofd 2.7 08-nov-2007 1 \
VENDOR_STRI NG=" 81AAAAAA : NNWCSO WSVFW/Z JOXDHFS NRMA2YN \
BHAHUW2 JMAJG J OEYHMLW ST" HOSTI D=8laaaaaa START=11-nov-2007 \
S| G\="03E6 6359 6509 5297 45E2 6EB6 DBAF B148 04BF DE83 C502 \
E872 86AA 522C 9257 369B BE71 A3F5 4FDE 16E2 F13F"

Using the Agilent License Information Tool

The Agilent License Information Tool is available to check your environment variable settings, display your license.lic
file, and show your license and server status.

To run this tool from the ADS Main window, choose Tools > License Information.

To run it from the terminal window, type the following line
$HPEESOF_DI R/ bi n/ agl nt ool

and press Enter to display the following window:

For a current list of codewords available from Agilent EEsof with product descriptions and part numbers, see
http://www.agilent.com/find/eesof-cwtables.

61



http://www.agilent.com/find/eesof-cwtables

Advanced Design System 2008

i Agilent License Information 27001@sunroof.wiv.agilent.co :..;-- Fil - IEIIEJ

AGILEESCOFD _LICENSE _FILE 270018 =zunroof _wlv_agilent con :j
270019katsura wlv _agilent con

270019 chester wlv_agilent  con

Comnputer-Hostnames = ADD49059

Default Ho=tid = 000bcd5a393b 000802e0f886 444553544200
Dizgk Serial Humber = §409dfg8

Ethernst Address = 000bcd523%93b 000802=0f886 444553544200
HPEESOF _DIR = C:~ADS20064

Hardware Kev (Dallas) =
Hardware Key (Sentinel) = =

Hardware Key (USE) =

IFP Addres=ss = 192.168.0.100

LH_LICENSE _FILE = 27001@sunroof . wlv. agilent  com
270019katsura wlv. agilent com
27001@chester wlv. agilent com

FATH =

C:~ADS20064™bin
CoxADSZ20064 adsptoleny-biltnaps =
| »

4]

[~ Compact View

Cancel Hefrezh I Help

Using the Agilent License Preference Tool

This section applies only to customers who have purchased license bundles.

If you have been using license packages in previous versions, you should be aware that license bundles replaced
license packages beginning in ADS 2003A. License bundles are either Pay-Per-Use License (PL) bundles, or Limited
Term Package (LTP) bundles. Typically, only PL or LTP bundles are available on a system - not both. A bundle looks
like any other INCREMENT line in the license.lic file, but ADS recognizes the feature name as a collection, or bundle, of
individual features. When ADS checks out the license bundle, it enables all the functionality associated with the
individual features.

You must select a license bundle when starting ADS, and the License Preference Tool is available to help you make a
selection. This sets the environment variable AGILEESOFD_LICPREF<hostname>. Since you cannot check out more
than one bundle, you have more control over which license bundles are used during an ADS session. You only need to
run the License Preference Tool when you want to change the latest bundle selection. If you need more bundle
selection flexibility to control which licenses are used on selected systems, see Manually Setting the License Bundle
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Preference.

Running the License Preference Tool

To run the License Preference Tool:

UNIX and Linux

There are two ways to start the License Preference Tool. In a terminal window:

e When starting ADS, enter ads - p. This runs the License Preference Tool, then runs ADS after you finish choosing
bundles.

e To run the tool as a standalone utility, enter $HPEESOF_DI R/ bi n/ agl npr ef . This runs only the License Preference
Tool.

Windows

There are two ways to start the License Preference Tool:

e From your Start menu, choose Programs > Advanced Design System 2008 > ADS Tools > License Preference
Tool.

e Modify the ADS shortcut located on the Start menu. Right-click the Advanced Design System icon, and choose
Properties. Edit the shortcut command on the Target line to include the - p option as shown in this example:
C: \ ADS2008\ bi n\ ads. exe -p
This runs the License Preference Tool every time you start ADS.

The License Preference window appears similar to the figures below. It enables you to view the available bundles and
their features, and select bundles.

e To see the features available in a bundle, click the expansion icon next to the bundle name under Available
License Bundles.

e To select a bundle, choose one of the bundles listed under Available License Bundles, then click Add. The
selected bundle appears under Selected License Bundles.

e To accept your choice, click OK. This sets the environment variable AGILEESOFD_LICPREF<hostname> in
$HOME/hpeesof/config/hpeesof.cfg.

 Note

You must have write permissions to update this file.
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|

Agilent License Preference

Avallable License Bundles

License Bundles / Features

Selected License Bundles

License Bundles / Features

H-1tp_comm_dsp_dg
Itp_design_guides
H-Itp_intdesrfde
Itp_intdesrfde_full

m-Itp_rf_mw_dg
r-Itp_rfic_dg
H-Itp_rfic_rfde
e-Itp_rfrmw _entry
H-pl_deseny
H-rfde_premier
r-rfde wireless
E-rfde wireline

OK

Add ==

<< Remove

Cancel

Help

License Preference Tool with Itp_analog Selected
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=| Agilent License Preference

Available License Bundles =elected License Bundles

License Bundles / Features

H-Itp_comm_dsp_dg
M-It _design_guides Add == s datadisplay
M-It _intdesrfde —ads layvout

-t _intdesrfde_full << Remove —ads_schematic
mHItp_integrated_dg — —dg_filter
H-Itp_mmic —dg_passives

-1t rf_mw_dg —mdl_multilayer
-t rfic_dg —mdl_rfelements
H-Itp_rfic_rfde —Mmarm_opt

-1t rfrw_entry —MOM_Wis
H-pl_deserny —marmentum
H-rfde_premier —im_corvalution
F-ride wireless —sim_harmonic
EHrfde wireline —sim_linear

OK Cancel Help

License Preference Tool Showing Itp_analog Features

How the License Preference Tool Works

When you run the License Preference Tool, it attempts to locate a license file using the following license
definitions:

° Environment variable AGILEESOFD_LICENSE_FILE

° ¢ HPEESOF_DIR/licenses/license.lic

° agl mtool -c <port_address>@<hostname> (example port address is 27000)
The License Preference Tool will show all possible bundles if a license file is not located.
You can select a bundle according to specific rules controlled by the License Preference Tool. See
Bundle-Selection Rules.

ADS will start when a license bundle is selected, and ADS will not use a bundle unless it is selected using the
License Preference Tool.
If, while using ADS, the feature you attempt to use is not in the currently selected bundle, ADS will attempt to
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check out a valid floating or nodelocked license for the feature. This is known as license roll-over. If license
roll-over fails to check out a license, a license error will appear even if another bundle with the requested feature
is available.

You can then select another bundle that contains the feature. Save your work, and exit ADS. Then run the
License Preference Tool to remove and add bundles, and restart ADS.

Bundle-Selection Rules

The License Preference Tool controls bundle selection using the following rules. A warning message appears for any
incorrect selection.

If you are using Limited Term Package Bundles

LTP bundles (except ltp_design_guides) contain a design environment codeword (ads_schematic) enabling ADS
to run. You must select an LTP bundle containing a designh environment codeword for a license preference to
occur.

Only one LTP bundle containing a design environment codeword can be selected at a time.

The Itp_design_guides bundle (if available) can be selected with any other LTP bundle except Itp_iccap.

Any PL bundles available on your system cannot be selected with an LTP bundle.

If ADS and RF Design Environment are installed on the same UNIX or Linux system, RFDE bundles cannot be
selected with LTP bundles.

If you are using Pay-Per-Use License Bundles

The pl_desenv and pl_ui bundles contain a design environment codeword (ads_schematic) enabling ADS to run.
You must select either pl_desenv or pl_ui for a license preference to take place. Other PL bundles appearing
under pl_desenv are not selectable.
Any LTP bundles available on your system cannot be selected with PL bundles.
After selecting a PL bundle, you cannot select any additional bundles except for the following conditions:

° The pl_design_guides bundle (if available) can be selected with the PL bundle.

° If ADS and RF Design Environment are installed on the same UNIX or Linux system, only the pl_rfde bundle

(if available) can be selected for RFDE.

Using Advanced Design System

To help you get started using ADS, this section includes some basic information along with useful tips for resolving
problems that might occur after you have installed ADS.
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Running Advanced Design System

Environment variables must be set before you can run ADS. To set the environment variables, see Configuring User
Accounts.

Your FLEXnet license file must be properly configured and installed before you can run ADS. To set up your license file,
follow the instructions in Setting Up Licenses for UNIX and Linux Installation.

To run ADS, open a terminal window and enter the command:

ads

Choose Help > Topics and Index > Quick Start for help on getting started with ADS.
Starting ADS in Verbose Mode (Debug Mode)

ADS 2006 Update can be started in verbose (debug) mode to display more information about what is occurring as ADS
runs. This extra information can be very useful to debug a problem with ADS both at startup and in general operation.
In verbose mode, ADS writes log files that can be used by Agilent EEsof EDA Technical Support to help track down any
problems.

To start ADS in verbose mode, do the following:

1. Open a terminal window.
2. Type ads_verbose.

This will start ADS. You will see some messages indicating the location of two log files. Note the location of these files
as indicated in the messages. The file names are as follows:

ads_daemon.log
ads_verbose.log

© Note

If ads_verbose is not found, you may need to set the HPEESOF_DIR and PATH environment variables.

Run ADS until the problem you are trying to debug occurs, then take a look at the ads_daemon.log and
ads_verbose.log files for errors.

If you can't locate the trouble based on the contents of the log files, please contact Agilent EEsof EDA Technical
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Support. You will want to e-mail the log files to the support engineer working with you.

Using 32-bit Simulators on a 64-bit Operating System

On a 64-bit operating system, you can either use the default 64-bit simulators or you can use the 32-bit simulators.
To use the 32-bit simulators on a 64-bit system, do one of the following:

e Set the EESOF_64BIT environment variable as follows:
EESOF_64BI T=0

or

e Start ADS by opening a terminal window and entering the command:
ads -32bit

If ADS Does Not Start

It is possible to install programs or options for which you have not purchased licenses. Although the icons and features
will appear in the software, you cannot access the applications without a license. Contact your Agilent EEsof sales
representative to obtain additional licenses.

If your ADS applications will not start:

e Make sure all of your licensing requirements are correctly set up, as explained in Setting Up Licenses for UNIX
and Linux Installation.

e Using a text editor, open and review the install.log file in your installation directory to see if there are any
apparent problems with the installation structure. (You can re-run Setup if necessary to re-install.)

e Try using the Agilent License Information Tool, which is available to check your environment variable settings,
display your license.lic file, and show your license and server status. Refer to Using the Agilent License
Information Tool.

If you cannot find the problem, run ADS in verbose (debug) mode and contact Technical Support to help pinpoint the

problem. See Starting ADS in Verbose Mode (Debug Mode).

Common Licensing Problems

Following are solutions to common problems that occur regarding the FLEXnet licensing setup for ADS.

For details on using FLEXnet and Imtools, refer to the Macrovision website at:
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http://www.macrovision.com/

Choose Products > FLEXnet

Where to Begin

If you are having trouble getting FLEXnet working, the best place to begin troubleshooting is the flex.log file. The
flex.log file is typically located in $HPEESOF_DIR/licenses.

Read the flex.log file and look for error or warning messages.

If nothing shows up in the flex.log file, try setting the following environment variable, then start ADS:

C Shell ( /bin/csh)

set env HPEESOF_DEBUG_MODE key

Bourne/Korn Shell (/bin/sh, /bin/ksh)

HPEESOF_DEBUG_MODE=key
export HPEESOF_DEBUG_MODE

Look for errors or warnings in the shell where you started ADS.

Common Errors and Solutions

Following are possible solutions to certain license-related error messages that occur.

ADS Does Not Run After Starting the License Server

If the following error message appears when you run ADS, additional license configuration may be needed:

No such feature exists
Feature: ads\_schematic
Li cense pat h:
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$HPEESOF\ _DI R/ | i censes/|icense.|lic; $HPEESOF\ _DI R/ | i censes/ | i censes. dat
FLEXIm error: -5, 357

This error can appear if your license.lic file contains license bundles and you have not run the License Preference Tool
to select a license bundle. You must select a license bundle using the License Preference Tool, so ADS will know to use
it.

Inconsistent Encryption Code

This error occurs when the information on the INCREMENT lines in the license.lic file is corrupted. Check the license.lic
file for the following:

1. Make sure that each line of the license.lic file is a single continuous line with each field separated by a single
space.

2. If there are backslash characters ("\") line wrapping the lines, make sure that the backslash character is the
absolute last character on its line. Even a space after the "\" will cause a problem.

3. Try removing the backslash characters and joining the INCREMENT lines, so that each INCREMENT line is a single
continuous line with no line wrap.

4. If the license.lic file was transferred from DOS to UNIX or Linux, make sure to remove the control M's ("M) at
the end of all the lines in the license.lic file. If spaces are added to the end of each line to eliminate the ~M's, the
spaces must also be removed. The spaces turn out to be just as disruptive as the ~M's. The best way to remove
the ~AM's is using the vi editor and the following substitution command:

:1,$s/.%//g

5. Make sure that none of the original SERVER line hostid information has been changed. Make sure that none of

the SERVER lines have been eliminated.

Invalid Host or Unable to Determine Machine ID

This can be caused by one of the following:

1. Make sure that the information on the SERVER line(s) in license.lic is correct.

2. If the licenses are node-locked, and you attempt to run ADS on a machine other than the machine the licenses
are node-locked to, you will get a license error indicating invalid host. To check if this is the case, look at the
$HPEESOF_DIR/licenses/license.lic file and check the INCREMENT lines. If each INCREMENT line ends in a
machine hostid, then the licenses are node-locked to the machine whose id is shown. You can, however, export
the display from the node-locked machine to another display.

3. If you are on an HP workstation, check the permissions of the /dev/lan0 file. This file must have read and write
permissions for all:
chrmod 777 /dev/1an0
The FLEXnet Imgrd and agileeosf vendor daemons use this file and must be able to read and write to this device.
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Invalid System Clock Time

FLEXnet detects when systems have had their dates set more than 24 hours back, and prevents users from using
expired licenses by setting the clock back. It works by looking for any files in "/" or "/etc" that have a date more than
24 hours in the future.

Use the command Is -lat in "/" and "/etc" to find the offending file(s). The date of the offending file(s) can be
corrected by using the touch command:

touch <fil enanme>

If the file is a link, the link must be removed and then recreated. If the link itself is dated ok, check the date of the
actual file or directory it points to. The pointed to file must also have a valid date.

A Feature is Not Enabled

FLEXnet codewords have both enable and expiration dates. If the codeword enable date is in the future with respect to
the current machine date, then this error will occur.

First check the date on the computer. If it is not today's date, correct it. The date can be set using the date command:

Workstation Date Command
Red Hat Linux date MVDDhh[[cc]yy][. ss]
Solaris dat e mmddhhmmi [ cc] yy]

For example, to set the date on a UNIX system to 23 Sept, 2004 at 13:30, the command would be:

date 0923133004

If this still does not correct the problem, or if the date is correct, then request new codewords with an enable date set
to today's date.

Cannot Connect to License Server

If you see a flex.log file with the following errors:

(Imgrd) Started agileesofd
(agileesofd) Vendor daemon can't talk to Imgrd (cannot connect to

71



Advanced Design System 2008

license server) port 27000

(Imgrd) Vendor daemon died with status 241

(Imgrd) Since this is an unknown status, Imgrd will
(Imgrd) attempt to re-start the vendor daemon.
(Imgrd) REStarted agileesofd (internet tcp_port xxxx)

Make sure that the Imgrd and agileesofd daemon are the correct version (current version is 11.4.1). The Imgrd
daemon should have the same or higher version number as agileesofd. You can check version numbers as follows:

cd $HPEESOF DI R/ | i censes
.Ibin/lmgrd -v
./vendor s/ agi | eesofd -v

Make sure that the workstation is connected to a network or that the network connector on the workstation is properly
terminated. FLEXnet will not work if the network connection is down or if the network services are not starting
properly. Check all physical network connections to make sure that they are okay and look for errors during machine
boot up. On HP 700 workstations, look at the /etc/rc.log file for errors.

Make sure that the agileesofd is being started successfully by Imgrd. If agileesofd cannot be started from the path
specified on the VENDOR line in the license.lic file, this error will occur. Also make sure that the agileesofd file has

execute permissions:

cd $HPEESOF_DI R/ | i censes/ vendors
chrmod 755 agi | eesofd

Address Already in Use

The tcp port number specified on the SERVER line in the license.lic file is in use by another process. Try the following:
Kill any stranded Imgrd processes. Remove the

/ usr/tmp/.flexnet/Imgrd.xxxx file that contains the tcp port you want to use. You can remove the entire
/usr/tmp/.flexnet directory if you are the only one using Imgrd on this machine, then restart Imgrd. If you still have a
problem, try using a different tcp port humber on the SERVER line in license.lic and then restart Imgrd.

Here is an example of properly configured SERVER lines:

SERVER j oshua 2072EFE45 27000
SERVER i sai ah 20472A3D3 27000
SERVER j onah 2052C6416 27000
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Printing and Plotting

Printing and plotting from ADS on UNIX is accomplished by establishing the desired print setup and then choosing File
> Print. The Print Setup and related dialog boxes enable you to:

Select a printer/plotter other than the default
Install additional printers or plotters

Set the print resolution (dpi)

Scale the output

When you select a printer/plotter, you can also change the following default printer/plotter-specific options:

e Page Size

e Source (Paper Tray)

e Duplexing (Double-sided)

e Orientation (Portrait or Landscape)
e Color (Black and White or Color)

When you choose File > Print, you can select from the following additional options:

Choose to send output to a printer/plotter or print to file
Scale the output to fit to the page

Select a file format (if printing to file)

Specify the number of copies

Your print setup is saved in $HOME/.Xprinterdefaults. If you do not have a local copy of this file, or the file .Xpdefaults
(from a previous release), the default file is read from the $HPEESOF_DIR/xprinter directory. When you change your
print setup, the changes are saved (as new defaults) to $HOME/.Xprinterdefaults.

© Note

If you do have a file .Xpdefaults (from a previous release), the settings of this file are copied to the new
filename to serve as the starting point for your print setup. Both files are valid, depending on which release of
ADS you are using. The old file is maintained for running an earlier version of ADS, but the new file is used
when you run ADS 1.5 (or later).

Setting Up a Printer

The Print Setup dialog box enables you to setup and manage your printer options. To access the Print Setup dialog
box,
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|

Print Setup:1

Printer

Name:

Model Info:

HP LaserJet 6150 Series on cae3si

HP LaserJet 6150 Series

Printer Management...

Resolution (dpi): J00

Scale Factor (%): 100

Orientation

' | '® Portrait _) Landscape

-' | £ Hepr

. | @ Eack mul White ) Jaloe

Paper
Size: Letter
Source: Upper
Duplexing: MHone
oK Apply

Cancel, Help

For detailed information on using the Print Setup dialog box, refer to the following table.

Using the Print Setup Dialog box

Option

Printer

Name:

Printer Management

Model Info:

Resolution (dpi):

Scale Factor (%):

Description

Use this section of the Print Setup dialog box to define
and manage your printers.

Select a printer from the Name drop-down list. If the
printer you want to use is not available in the list, click
the Printer Management button. For more information,
refer to Managing Printers.

If you want to add, replace, or remove a printer, click
the Printer Management button to access the Printer
Management dialog box. For more information, refer to
Managing Printers

This section displays the selected printer model
information.

This option enables you to set the print quality
(resolution) in dots per inch (dpi).

This option enables you to set a scaling factor that
defines the percentage of normal size by which to
enlarge or reduce the document on the page. Default is
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100%.

Paper Use this section of the Print Setup dialog box to define
the paper settings.

Size: Use the Size drop-down menu to select the paper size.
Default is Letter.
Note that paper sizes can vary depending on the paper
manufacturer. If you own a printer that provides a
specific paper size that you are not familiar with, consult
your printer manual for information on the paper size
options available. The more common American paper
sizes are listed below in inches (Width vs. Height).
Letter = 8.50" (W) x 11.00" (H)
Executive = 7.25" (W) x 10.55" (H)
Legal = 8.50" (W) x 14.00" (H)
Tabloid = 17.00" (W) x 11.00" (H)
Ledger = 11.00" (W) x 17.00" (H)
Consult the International Organization for
Standardization (ISO) for standard A through D-sizes as
well as RA and SRA-sizes.

Source: Use the Source drop-down menu to select the tray that
has the paper you want to use. Default is the Upper tray.

Duplexing: The Duplexing drop-down menu enables you to print on
both sides of the paper. The options available are:
-None - No duplexing, the document will only print on
one side of the paper.

-Flip on Short Edge - This option prints on both sides of
each sheet and flips the page along the short edge of the
paper.

- Flip on Long Edge - This option prints on both sides of
each sheet of paper and flips the page along the long
edge of the paper.

The default Duplexing option is None.

Orientation Use this section of the Print Setup dialog box to define
the orientation of your printed page.

Portrait Click this option if you want your output printed in
portrait orientation mode. Portrait is taller than it is wide
when you view the text right-side up. Default is
activated.

Landscape Click this option if you want your output printed in
landscape orientation mode. Landscape is wider than it is
tall when you view the text right-side up. Default is
deactivated.

Color Use this section of the Print Setup dialog box to define
your color settings.
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Black and White Click this option if you want your output in black and
white. Default is activated unless the system detects
support for color printer. If this is the case, the system
will default to the color option.

Color Click this option if you want your output in color. Default
is deactivated unless the system detects support for
color printer. If this is the case, the system will default to
the color option.

Managing Printers

The Printer Management dialog box enables you to manage an individual printer or group of printers. To access the
Printer Management dialog box,

1. Choose File > Print Setup. The Print Setup dialog box appears.
2. Click the Printer Management button in the Print Setup dialog box. The Printer Management dialog box appears.

—| Printer Management:1 |
Installed Printers
'T-IPLaserJe-tﬂ-ﬁi]Ee;es-u;c-aﬂasr--------------------------j
Generic PostScript Printer on FILE:
HP Color Laser.Jet P35 on caecl)
HP Design.Jet 755CM PostScript on caednj
Hote: To install a printer, select a printer driver and a port
Printer Drivers Defined Ports
APS3-P3 PIP with APS-6-108 ! | cae3si=lp -d cae3si
Auld Repiace Hempve Ports...
Help Close

For detailed information on using the Printer Management dialog box, refer to the following table.

Using the Printer Management Dialog Box
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Options

Installed Printers

Printer Drivers

Defined Ports

Ports

Add

Replace

Remove

Help

Close

Defining Printer Ports

Description

The Installed Printers field displays a list of all currently
installed printers.

Use the Printer Drivers drop-down list to select a printer
driver.

Use the Defined Ports drop-down menu to select a
defined port.

To define a new printer port and/or replace or remove an
existing printer port, click the Ports button to access the
Ports dialog box. For more information on the Ports
dialog box, refer to Defining Printer Ports.

To install a new printer, select a printer driver and a
defined port, then click the Add button. The new printer
appears in the Installed Printers list.

To replace an existing printer, click the printer you want
to replace in the Installed Printers list. Then select a new
printer driver and a new defined port. Click the Replace
button to replace the printer. The new printer appears in
place of the old printer in the Installed Printers list.

To remove an existing printer or group of printers, click
the printer(s) you want to remove in the Installed
Printers list and then click the remove button.

A confirmation dialog box appears asking if you really
want to remove the printer. Click OK to confirm or
Cancel to abort the removal process. If you click OK, the
printer(s) no longer appears in the Installed Printers list.

Click the Help button to access the online context
sensitive help.

Click the Close button to dismiss the Printer Management
dialog box and accept the changes. Settings will be
saved upon exit.

The Ports dialog box enables you to define new printer ports and/or replace or remove existing printer ports. To

access the Ports dialog box,

1. Choose File > Print Setup. The Print Setup dialog box appears.
2. Click the Printer Management button. The Printer Management dialog box appears.

3. Click the Ports button. The Ports dialog box appears.
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|

Ports:

Ports

caeisi=lp -d cae3si
caeclj=Ip -d caeclj
caednj=Ip -d caednj
local=lp -t$<XPDOCHAME

Edit Fort

AddfReplace

FonysEys

Import from Spooler Help Close

For detailed information on using the Ports dialog box, refer to the following table.

Using the Ports Dialog Box

Option

Ports

Edit Port

Add/Replace

Remove

Import from Spooler

Help

Close

Description

The Ports field displays a list of ports. Port names can be
any names you choose with the exception of FILE: which
is a reserved port name.

The Edit Port field is used to enter a new port. After you
have entered the port definition, click the Add/Replace
button.

Click the Add/Replace button to update the Ports list with
contents of Edit Port field.

If you want to remove a port from the Ports list, click the
port nhame in the Ports list to activate the Remove
button. Click the Remove button to remove the selected
port.

Click the Import from Spooler button to generate a list of
ports (based on your printcap file).

Note that this option is only guaranteed to operate on
HP-UX platforms. It may operate on other platforms;
however, the third party utility that provides this feature
does not guarantee it.

Click the Help button to access the online context
sensitive help.

Click the Close button to dismiss the Ports dialog box
and accept the changes. Settings will be saved upon exit.
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Printing to a Printer, Plotter, or File

The Print dialog box enables you to output your information to a supported printer, plotter, or specified file. To access
the Print dialog box,

1. Choose File > Print. The Print dialog box appears.

=| Print:1

Printer
Hame: HP LaserJet 8150 Series on cae3si Properties...
Model Info: HP LaserJet 8150 Series X Ht to Page
Status: Ready | Print to File
Copies fahad fn Rie

Humber of Copies: - [ 1 fie Fermals VRGO pgd

OK Cancel  Help

 Note

Alternatively, you can click the Print The Current Design button in the toolbar of a Schematic or Layout window
to access the Print dialog box. The Print this window button in the Data Display uses the same user interface.

For detailed information on using the Print dialog box, refer to the following table.

Using the Print Dialog Box

Option Description

Printer The Printer options in the Print dialog box enable you to
define a printer and the output characteristics.

Name: Select a printer from the Name drop-down list. If the
printer you want to use is not available in the list, click
the Cancel button and access the Print Setup dialog box.

Model Info: This section displays the printer model information.

Status: This section displays information on the printer status. If
the printer is ready to print, the Status will display
Ready.
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Properties

Fit to Page

Print to File

Copies

Number of Copies

Print to File

File Format:

OK

Cancel

Help

Printing to a File

Advanced Design System 2008

Click the Properties button to view or set additional
options used in the Print Setup dialog box. For more
information, refer to Setting Up a Printer.

Activate the Fit to Page option if you want your output to
be automatically scaled to fit on the page.

Activate the Fit to Page option if you want your output to
be directed to a file.

When this option is selected, the Number of Copies
feature is deactivated and the Print to File feature is
activated.

When this option is deactivated, the Number of Copies
feature is activated and the Print to File feature is
deactivated.

This section is used to set the number of copies to print.

Use this feature to specify the number of copies to print.
If Print to File is selected, this feature is deactivated.

This section is used to define the type of file you want to
send your output to.

Use this feature to specify the file format to save your
output to.

After you have selected your file format, click OK in the
Print dialog box. A Print to File dialog box will appear
enabling you to define the path and name of the file. For
more information on the Print to File dialog box, refer to
Printing to a File

If the Print to File radio button is deselected, this feature
is deactivated.

Click the OK button to accept the settings and send your
output to the selected printer or file, depending on how
you have set your options. Settings will be saved upon
exit.

Click the Cancel button to dismiss the Print dialog box.
Settings will not be saved upon exit.

Click the Help button to access the online context
sensitive help.

The Print to File dialog box enables you to define a destination path and file name and then output your information to
the specified file. To use the Print to File dialog box,

80



Advanced Design System 2008

1. Choose File > Print. The Print dialog box appears.

=| Print:1

Printer
Ha HE L aseriel 8158 Sevies an caels | Proparies.
Model BB 4P Lasendet B158 Serles B G Page
Hhalus: Bigraualy # Print to Fle
L Print to File

tranber of Coples: o ] o File Format: | JPEG (*.jpg)

0K Cancel  Help

2. Select the Print to File option in the Printer section of the Print dialog box. Notice that when you select the Print
to File option, the Print to File section is activated enabling you to select a file format.

3. Use the File Format drop-down list to select the desired file format. Options include JPEG, GIF, PDF, Bitmap, and
HP-GL/2.

4. Click OK in the Print dialog box. The Print to File dialog box appears.

=| Print To File:1 |

Filter

jusersfcrscott/MYPROJ_prir]

Directories Files

[ ]
~_pyf.

~_prjfdata

" prifmom_dsn
~_primetworks
~_prifsynthesis
~_pyfverification

Selection

fusersicrscottfMYPROJ prjé

Ok Filter Cancel

5. Enter the file name for your output in the Selection field.

81



Advanced Design System 2008

6. Click the OK button to output the file.

Using IC-CAP 2004 with ADS

ADS 2006A and ADS 2006 Update includes a program named iccapinterface that enables IC-CAP 2004 to launch the
ADS simulator. To enable IC-CAP to link to the ADS simulator, do the following:

1. Change the following entry in your IC-CAP usersimulators file from:
hpeesof si m hpeesof si m $I CCAP_ROOT/ bi n/ hpeesof sim start "" CAN_PI PE
to
hpeesf osi m hpeesof si m $ADS_DI R/ bi n/i ccapi nterface "" CAN_PI PE
2. Make sure the environment variable HPEESOF_DIR is set to point at the ADS installation directory. IC-CAP 2004
will resolve the reference to ADS_DIR in the usersimulators file based on the HPEESOF_DIR value.

Agilent EEsof Technical Support

Agilent EEsof worldwide technical support is available Monday through Friday. The toll-free North America hotline is
open 6:00 am to 5:00 pm PT. Throughout Europe, the localized Online Technical Support Centers are open during
business hours, typically 8:30 am to 5:30 pm, local time; throughout Asia, the localized Customer Response Centers
are open during business hours, typically 9:00 am to 6:00 pm, local time.

The e-mail addresses for the various regions are listed below. However, for both the regional e-mail addresses and
local telephone numbers for more than 25 countries, please refer to the Agilent EEsof Web site at

http://www.agilent.com/find/eesof-supportcontact
North America

Phone: 1 800 47 EEsof (473-3763) - Fax: 707-577-3511
e-mail: eesof support@agilent.com

Europe: e-mail: eesof-europe_support@agilent.com
Japan: e-mail: eesof-japan_support@agilent.com
Korea: e-mail: eesof_korea@agilent.com

Asia: e-mail: eesof-asia_support@agilent.com
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Using Remote Simulation on a UNIX or Linux Client

Use the following information to enable and run remote ADS simulations using a UNIX or Linux client. Before starting
the client process, you must first set up a server (host) computer on which to run remote simulations.

In this chapter, the term server has the same meaning as host or remote computer, and the term client has the same
meaning as local computer.

 Note

These procedures are different for the Momentum Electromagnetic simulator. For Momentum remote
simulation, refer to "Performing Remote Simulations" in the Momentum documentation.

Remote simulation with a UNIX or Linux client works among the following system pairs:

e UNIX or Linux to UNIX
e UNIX or Linux to Windows XP
e UNIX or Linux to Linux

 Note

The LSF type of remote simulation is described in Using LSF Remote Simulation. LSF remote simulation is NOT
supported by schematics with layout components or Momentum.

Setting up Your Simulation Server

Setting up a UNIX or Linux Server

To prepare a UNIX or Linux server (remote computer), perform the following steps:

1. Log in to the remote computer.
2. Set the HPEESOF_DIR, PATH, and DISPLAY environment variables as you normally would when running ADS.

 Note

DISPLAY must be set if you are running ADS Ptolemy simulations with TkPlots in them. This allows the server
to display the TkPlots on the client machine.

3. Set the TCP communication port (socket address) in the server using one of the following methods. This provides
the socket address to the hpremote script. If you are unfamiliar with setting socket addresses, see details about
these methods in Defining the EMX Daemon Remote Address.

¢ Edit the file $HPEESOF_DIR/config/hpeesof.cfg to set the socket address. Add the following line:
EEDAEMON_SOCKET = XXXX
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where xxxx is the socket address, such as 1537.
e Edit the file /etc/services to set the socket address. Add the following line:
eedaenon xxxx/tcp eedaenon
where xxxx is the socket address, such as 1537.
¢ Do not define a socket address, which allows the EMX daemon started by the hpremote script to use the
default socket address of 1537. This method may be unreliable.

 Note

Momentum requires an additional line in the hpeesof.cfg file, which is:
MOVENTUM _SI M_PATH=<r enpt e_conput er _nanme>
Refer to the Momentum manual in Simulation > Performing Remote Simulations.

4. Run the following script on the server:
hprenote -d /tnp/renmote_siml og
The -d option is for debugging purposes. It allows you to see the screen messages and save them in the
remote_sim.log file for later verification. This file will be stored in the /tmp directory.
If you get an error message, see Simulator Server Error and Remote Simulation Error.
To view the last part of the file, use the following command:
tail -f /tnp/renpte_simlog
5. You can verify that the hpremote daemon is running by checking the process:
ps -ef | grep hpeesof enx

 Note

If another user has already launched the hpremote, then it must not be launched a second time. Subsequent
remote users (you in this situation) can connect to this daemon as well. Make sure that the HPEESOF_DIR is
set correctly for your simulation.

Setting up a PC Server

To prepare your PC server (remote computer) perform the following steps:

1. Set the TCP communication port (socket address) in the PC server using one of the following methods. This
provides the socket address to the hpremote script. If you are unfamiliar with setting socket addresses, see
details about these methods in Defining the EMX Daemon Remote Address.

¢ Edit the file $HPEESOF_DIR\config\hpeesof.cfg to set the socket address. Add the following line:
EEDAEMON_SOCKET = XXXX
where xxxx is the socket address, such as 1537.

e Create a new hpeesof.cfg file in the folder C:\users\default\hpeesof\config. Add the line shown in the
example above to it.

e Do not assign a socket address to EEDAEMON_SOCKET. This allows the EMX daemon started by the
hpremote script to use the default socket address of 1537. This method may be unreliable.

 Note

Momentum requires an additional line in the hpeesof.cfg file, which is:
MOVENTUM _SI M_PATH=<r enpt e_conput er _nane>
Refer to the Momentum manual in Simulation > Performing Remote Simulations.

2. Start the Remote Simulation daemon with the command:
<HPEESOF_DI R>\ bi n\ hprenote -d renote_si ml og
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from an MS-DOS command prompt or from the Windows > Start > Run menu.
The -d option is for debugging purposes. It allows you to see the screen messages and save them in
remote_sim.log file for later verification. This file will be stored in $HPEESOF_DIR\bin.

 Note

Do not terminate the MS-DOS window that pops up. Doing so will immediately terminate the daemon as well.

The Server (remote) PC is now ready to run ADS simulations started on a client.

Setting up a UNIX or Linux Client

It is recommended that you first edit the client's hpeesof.cfg file, located in the $HPEESOF_DIR/config directory to
include:

EEDAEMON_SOCKET = 1537

Again, while this socket is generally not used, you should make sure 1537 does not appear in the /etc/services file.
Also, even though 1537 is the default socket setting within ADS, best practices involve explicitly adding this line in the
hpeesof.cfg file. (See Defining the EMX Daemon Remote Address for details.)

A client machine should now be ready to run remote simulation. Do the following:

Start ADS.

Open or create a project.

Open or create a design.

From the Schematic window, choose Simulate > Simulation Setup.

In the dialog box that appears, type in the Host name (or Host's IP address) in the Remote Simulation Host field.
Click on Simulate.

ouALNE

If Remote Simulation succeeds, the Status window will open and show the progression of the simulation.

Whether you need any other setup on the client depends on user preferences and if an OPEN_SIMULATOR error
message occurs, see Simulator Server Error.

Using Multiple Servers

Multiple servers may be available on your system. Multiple servers are particularly useful when you intend to compare
circuit simulation results as quickly as possible. Once multiple servers are set up, they can be accessed by typing in
each name at a client computer, or by generating a listing on a client.
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This listing appears when you click the down arrow next to the Remote Simulation Host field. Normally this is a list of
one, defaulting to local and no others. However, you may write a list of hosts into the de_sim.cfg file on a client
computer. Edit the de_sim.cfg file, located in your $HPEESOF_DIR/config directory, or C:\users\default\hpeesof\config
(on PC) or $HOME/hpeesof/config (on UNIX/Linux) directory, to include the following line:

SI MULATI ON_HOST_LI ST=[ host nanel] [ host nane2]...

where each [hosthame] must be separated by a single space. After making this edit, start ADS. From the Schematic
window, choose Simulate > Simulation Setup. In the dialog box that appears, click the down arrow just to the right of
the Remote Simulation Host field, highlight the host you want, and click the Simulate button.

Automating EMX Daemon Startup

You may want to automate the startup of the EMX daemon each time the workstation boots. This can be done through
a resource configuration (RC) script such as the following.

Example of RC Script

The following is an example entry to start hpremote setup:

HPEESOF_DI R=<your installation directory path>

PATH=$HPEESOF/ bi n: $PATH

if [ -f $HPEESOF_DI R/ bi n/ hprenote ]; then
hprenmote -d /tnp/renmpte_simlog & fi

Simulator Server Error

For either a PC or UNIX/Linux server, if you get the following error message when running Remote Simulation on the
client:

(send_server_command) OPEN_SIMULATOR
server error

The EMX daemon may not be running on the Server. Check the Server:

e PC Try using the command hpremote -d <filename > to start the daemon. If a failure re-occurs, you can check
the log file <filename> saved in the $HPEESOF_DIR\bin directory to search for causes. On the client side, try
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typing in the Server's IP address instead of its machine name in the Remote Simulation Host field of the box that
pops up from Simulate > Simulation Setup.

e UNIX/Linux Please be sure you edited and ran hpremote as described above. Remember that adding
EEDAEMON_SOCKET = 1537 to hpeesof.cfg is recommended before running hpremote.

e PC and UNIX/Linux If you are sure hpeesofemx is running on the server, it may be listening to a different socket
address than the client seeks. Please verify that both client and server computers are using the same TCP
socket. It is recommended to use socket 1537, the default setting in ADS sought by clients.

Remote Simulation Error

For remote simulations using a UNIX or Linux server, if you receive an error message such as the following when
running the hpremote script:

[1] + Stopped (tty output) -hpeesofemx-d remote.log &

this might be an indication that you are running from a shell that does not write messages to tty for a background
process (tty gets the terminal name).

In this situation, use the following command in the hpremote script:

hpeesofemx 2>&1 &

Note that this message also appears if you are using remote simulation with Momentum.

Ending Remote Operation

To end a remote operation:

1. On the local machine, exit ADS.
2. Terminate the hpeesofemx daemon that is running on the remote server. In Windows, go to the Task Manager
and End the Process.
In UNIX and Linux, to find the process enter the command:
ps -ef | grep hpeesof enx
then kill the process using:
kill -9 <process |D>
The next time ADS is launched, it will default to simulate locally.
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Remote Simulation Restrictions

Please note that the following restriction applies to remote simulation:

In the Momentum simulator, if a substrate computation is required, you must set the
$HPEESOF_DIR/momentum/lib/substrates directory and the files under it accessible for reading and writing. However,
if you do not do this, the program will warn you.

Defining the EMX Daemon Remote Address

Remote simulation requires fixed socket addresses for the client(s) and server(s) computers. By default, the EMX
daemon started by the hpremote script uses a socket address of 1537. However, relying on this default setting may or
may not result in a successful remote simulation. Agilent Technologies recommends explicitly setting the socket
address using one of the two options below:

Li]

Important

Before setting a socket address, ensure that the number is not used in the /etc/services file nor the Windows
Services. NIS (Network Information Services) is not supported for setting the EMX daemon socket address,
and the address you use must not be used in NIS. To check NIS, use the following command where xxxx is the
address:

ypcat services | grep xxxxX

o Edit the $HPEESOF_DIR/config/hpeesof.cfg file for each client and server computer (PC or UNIX/Linux). Set the

variable EEDAEMON_SOCKET by adding the following line:

EEDAEMON_SOCKET = xXXXx

where xxxx is the socket address. The address can be 1537 or any other port humber that is not used elsewhere
(e.g., 5332). This socket address should be known and fixed across all associated client and host platforms. This
might require root or super-user privileges to make the change. Ask your IT department to help you, or create a
new hpeesof.cfg file in your $HOME/hpeesof/config directory and add the line above to it.

Edit the /etc/services file to set a socket address for EEDAEMON, such as

eedaenmon xxxx/tcp eedaenon
where xxxx is a humber such as 1537 or 5332. This method is useful in a multi-node environment. However, the

/etc/services entry must be identical on every node. This approach has greater power, but requires root or
super-user privileges to make the change, as in the option above.

Using LSF Remote Simulation

This section describes how to use LSF to perform remote simulations on one or more remote simulation servers.

LSF (Load Sharing Facility) from Platform Computing enables remote simulations with dynamic host selection. ADS
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integrates this facility to enable automatic remote host selection. Simple swept simulations can also be configured to
use many machines available on the network. We call this feature parallel simulation. A simple sweep can be set up to
run on a set of machines. LSF is used to select the best machine set. Individual sweep points are run on each machine
and results combined into a single dataset on the local machine.

For a machine to participate as a fastest host or in a parallel simulation it must have both LSF and ADS installed. ADS
also needs configuration changes to tell it what hosts are available. The feature is configured using the status server
configuration file hpeesofsess.cfg.

 Note

Momentum Electromagnetic simulator and schematics with layout components do not support LSF remote
simulation.

LSF Requirements

Supported Operating Systems for Use as a Server (Host):

e UNIX and Linux systems

Supported Operating Systems for Use as a Client (Local Computer):

e UNIX and Linux systems
e Windows XP

Supported LSF Software:

e LSF Standard Edition 6.2

Where to get LSF software:

http://www.platform.com

Where to get LSF documentation:

http://www.platform.com/services/support/docs home.asp
(requires password)

) Note

LSF is used largely to determine suitable hosts for remote simulations. Many of the LSF features, like queuing
and priorities, are unused in this release.
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Security

Security is minimal. It is assumed that ADS and LSF are being used in a trusted environment. It is possible to
accidentally use a different user's UNIX or Linux account when simulating.

Recommendations For Use

e For UNIX and Linux, all users who will be using ADS and LSF must have a common, shared, $HOME directory, on
all systems. Not only must the same $HOME directory name be used on all systems, but the same directory must
be used (typically, the same directory is mounted via NFS in the same location on all systems). In other words, if
a file in a user's $HOME directory is changed on one system, that change must be immediately reflected on every
other system.

e At least 100 MB of free disk space must be available on each system for use by temporary simulation data (the
more, the better).

e The disk space should be on a local disk. While network disks can be used, a significant simulation performance
degradation can be seen if network disks are used. For best performance, the free disk space should be on a disk
local to each system. This last statement is not in conflict with the requirement about $HOME directories. $HOME
directories must be shared (and, therefore, be on a network drive), but temporary disk space should be on a
local disk.

Setting Up LSF and ADS

Use the steps in the following sections to set up LSF and ADS.

Preliminary Setup

Y

Host Seript Setup

Y

Edit ADS Configuration

Y

Configure ADS Users

_ Y
Verify User §Path
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Preliminary Setup

The following preliminary steps should be taken:

1. Follow the LSF instructions to set up LSF at your site. Note that LSF servers must be running on every system
that you want to use as a possible simulation host. LSF clients must also be running on every system on which
ADS will be running. If LSF is not running, ADS will not be able to perform LSF-managed simulations.

2. Install ADS on every UNIX or Linux system that you want to use as a possible LSF remote simulation host, and
install ADS into the same location on each host (or use a symlink at the same location to point to where you
actually installed ADS). Alternatively, you can install ADS on one or more centralized servers, and have each
UNIX or Linux system access ADS via NFS and symlinks.

All systems must be able to access ADS using the same directory path. Use symlinks, if necessary, to meet this
requirement.

Setting Up Scripts on Each LSF Remote Host

Scripts on each LSF remote simulation host must be configured (if ADS is installed on centralized servers, the
following need only be done on each centralized server). Do the following for each remote simulation host:

1. First, determine a location for a temporary work directory. The default is /tmp. You can use /tmp or /var/tmp, or
some other convenient directory. However, you must have enough disk space at this location to hold the data for
each LSF-managed intermediate simulation. Be sure this is a local disk with at least 100 MB of free disk space. If
you plan on performing large simulations, you'll need more disk space (the more, the better).

While you do not have to use the same directory location on each LSF remote simulation host. However, using
the same directory location (using symlinks if necessary) will greatly simplify configuration in the following steps.

2. Copy the file, "$HPEESOF_DIR/sess/remote-sim-server", to "$HPEESOF_DIR/custom/config/remote-sim-server"
(this destination file should not already exist). Example:

dd $HPEESOF Dl R/ sess
dp renote-si mserver ../custom config/renote-simserver

3. The newly copied file, "$HPEESOF_DIR/custom/config/remote-sim-server", is a plain shell script. Edit this file and
appropriately change the settings of the "HPEESOF_DIR" environment variable to match the correct
HPEESOF_DIR value for the current host.
You must explicitly set the value for HPEESOF_DIR. You cannot rely upon the HPEESOF_DIR environment
variable being properly set when this script is run due to the way in which ADS executes this script.
(If the HPEESOF_DIR variable is set, it will have the value of HPEESOF_DIR for the system on which the ADS
graphical user interface is running. This may not be the correct value for HPEESOF_DIR on the remote simulation
host, which is the host on which this script will be run.)
In this script, the default value for HPEESOF_DIR is "/dev/null", which is clearly incorrect; this value was chosen
to emphasize the fact that this script must be edited.
Note that this script allows different platforms (Linux and Solaris) to have different values for HPEESOF_DIR;
make sure that you edit the correct occurrence of HPEESOF_DIR for the current platform.
You must also change the first line of the newly copied file from "#! /bin/sh" to "#! /usr/bin/sh".

4. Make sure that the newly copied file has execute permission, for example:
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chnod 555 $HPEESOF_DI R/ cust oni confi g/ renot e-si m server

Editing ADS Configuration Files

Next, on each LSF remote simulation host, one or more ADS configuration files must be edited (if ADS is installed on
centralized servers, the following need only be done on each centralized server).

The configuration can be controlled on a system-wide or per-user basis. System-wide configurations affect all users on
a system, but are simple to configure; only one file needs to be edited. Per-user configurations affect only a single
user, and take precedence over any system-wide configurations; however, you'll have to configure a file for each user.
You'll have to decide which is best for you. However, most users will be satisfied with a system-wide configuration.

1. To set a system-wide configuration, edit (create) the following file, and use steps 2 through 4 to set values in it:

$HPEESOF_DI R/ cust onf confi g/ hpeesof sess. cfg

To set the configuration for a single user, edit (create) the following file, instead, and use steps 2 through 4 to
set values in it:

$HOVE/ hpeesof / confi g/ hpeesof sess. cf g

2. By default, LSF-controlled simulations will use all available LSF hosts for remote simulations, and every available
host will be used for each simulation. For some sites, there may be issues with this:
e This assumes that ADS is installed/available on all LSF hosts. Some sites may have ADS installed/available
on only a subset of LSF hosts.
To restrict simulations to a subset of LSF hosts, you must create a list of hosts to which LSF simulations
may be submitted. See step 4 in this section, below, for instructions on how to set the LSF_HOSTFILE
variable.
e Some sites may want to limit the number of hosts that a single simulation can use.
To limit the number of LSF hosts that a single LSF simulation will use, you must set the variable
LSF_MAX_HOSTS. Example:
LSF_MAX_HOSTS = 17
This will impose a limit of 17 hosts when performing a single LSF simulation. Note that this limit applies to
each user's simulation. For example, if two users have a limit of 17, and both perform LSF-controlled
simulations, the maximum number of systems used is 34, and not 17.
If you need to limit both the hosts and the number of hosts, both methods can be used simultaneously.
3. You must tell ADS the location of the "remote-sim-server" script (from the section on scripts, above) on the
remote systems. You do this by setting the variable REMOTE_SIM_SERVER.
Example: If you installed ADS on the remote systems such that HPEESOF_DIR=/ADS2008, you would add this
line to the configuration file (without leading spaces):

REMOTE_SI M_SERVER = / ADS2008/ cust omf confi g/ renot e- si m server
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Do not use any environment variables when setting this variable; you must use the actual, absolute path name.
In other words, do not use a line such as:

REMOTE_SI M SERVER = $HPEESOF_DI R/ cust onf confi g/ renot e-si m server

This will not work, and will only cause problems.

4. If you did not choose /tmp as the temporary work directory (for all systems) in step 1 in the section on scripts,
above, you will have to tell ADS about this. If all systems will be using /tmp, you can skip this step.
You can specify a different temporary work directory for each remote simulation host, or you can specify that the
same directory path is to be used on each host. If you want to specify the same temporary work directory path
for all remote simulation hosts, you do so by placing a line like the following into the hpeesofsess.cfg file:

LSF_TMPDIR = / ny/ tnp/ dir

Replace /my/tmp/dir with the desired name of the temporary work directory. By setting LSF_TMPDIR, you are
specifying that this directory path is to be used as the default temporary work directory on all remote simulation
hosts.

If all systems will be using the same path specified by LSF_TMPDIR, you can skip the rest of this step.

If you need to restrict LSF simulations to a subset of LSF hosts, or if you want to specify different temporary
work directory names for some or all of the remote simulation hosts, you must create a file that lists each
remote simulation host and the corresponding temporary work directory (if different from the default). However,
if you create this file, note that only the systems listed in this file will be used by LSF-controlled simulations.
This file is specified using the variable LSF_HOSTFILE. Example:

LSF_HOSTFI LE = / ny/ path/to/ sone/ hostfile

This file can have any name, and it consists of text lines of the form:

<system name> [<tenporary_directory_nane>]

Where:

<system_name> is the name of a remote simulation host, including domain name. In other words, the name
must be a fully qualified domain name (FQDN).

Note that all systems must be within your local domain (the same domain as the system from which ADS is run).
You cannot specify systems that are not within your local domain. If you do, ADS may not work properly.
<temporary_directory_name> is the optional name of the temporary directory to use on the remote simulation
host. If this directory is not specified, the value of LSF_TMPDIR will be used, or, if LSF_TMPDIR is not set, /tmp
will be used.
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Example (assuming that your domain name is "gqptzx.com"):

dyst eml. gpt zx. com /tnp

qdyst en®. qpt zx. com / di sk2/tnp
dyst enB. gpt zx. com

dyst emd. gpt zx. com / sone/ di sk/ f oo

Note that system3 does not have an explicit temporary directory; since one is not specified, the value of
LSF_TMPDIR will be used or, if LSF_TMPDIR is not set, /tmp will be used. As only four systems are specified
here, the maximum number of LSF-controlled simulations is four (even though there may be more LSF-managed
hosts available).

As mentioned above, only the systems listed in this file will be used for LSF-controlled simulations, and so you
must insure that all systems that you want to use are listed here.

Also, make sure that all temporary working directories are writable.

The following is an example of an Isf_hosts.cfg file:

this is nmy LSF control file
Dat e: 8/ 12/ 2003
sirpoh will use /tnp
erver.yourconmpany.com /tnp
no directory specification => jane will use \* => /tnp/parallel.}}
ane. server. your conpany. com
joe will use /users/poh/tnp
oe. server.yourconpany. com / user s/ poh/tnp
generic tenporary directory #specification on a host |ine
/tnp/ parall el

X b e S (n S S S

Configuring Each ADS User

Each user running ADS must be configured. Basically, each user must use a different port number for LSF-controlled
simulations; this port number must be manually chosen and manually checked to ensure that the port number is not
being used by another user.

Once the port number is chosen, for each user (from a shell prompt) do the following:

nkdir -p $HOVE/ hpeesof/config echo "EEDAEMON SOCKET=12345" >> $HOVE/ hpeesof/confi g/ hpeesof.cfg

where you replace 12345 with the chosen port number.

Verifying the User's $PATH
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Before running ADS, the path to the LSF programs must be in each user's $PATH. To verify that LSF is in $PATH, you
can run the Ishosts command as a test, for example:

| shosts

Here, Ishosts should print a list of available LSF-managed hosts.

Installing Connection Manager Server for UNIX and Linux

Connection Manager server can be installed and used with RF Design Environment (RFDE) and Advanced Design
System (ADS). Follow these instructions to install the Connection Manager server and configure the server I0.

Obtaining the Software

The ADS 2008 release does not include installation for Connection Manger Server. To use Connection Manager Server
with ADS 2008, install Connection Manger Server from ADS 2006 Update 3 installation media. You could also
download the Connection Manger Server shipped with ADS 2006 Update 3 from Agilent EEsof Knowledge Center at:

You may need to have Agilent EEsof Knowledge Center login to access the above link. Please follow the remaining
instruction in this document to install Connection Manager Server.

Before You Begin

To communicate with instruments, you must install the Connection Manager server. Before installing the server,
ensure that your PC workstation and your EDA software licensing meet the following requirements.

System Requirements

The server must be installed on a Windows PC connected to the same network as the EDA software network server or
local installation.

© Note

Connection Manager Server cannot be installed on 64-bit machines.
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Requirement Description
Processor Pentium III 450 MHz or higher
RAM 256 MB
Hard Disk Space 500 MB on system drive
Operating System Windows XP Professional (Service Pack 1)
Network Configuration TCP/IP
Supported CD-ROM required for program installation.
Media Type
i Caution

If you have Toshiba Bluetooth Stack installed on your System then please uninstall it before installing
Connection Manager Server. Installing Toshiba Bluetooth Stack and Connection Manager Server on the same
system may cause undesirable effects including System Crash. You could uninstall Toshiba Bluetooth Stack
using following link on Windows:

Start->Control Panel->Add or Remove Programs

You could install Windows native Bluetooth drivers to use Bluetooth devices.

Licensing Requirements

Although the Connection Manager client requires a license, Connection Manager server does not require a license
regardless of where it is installed.

© Note

The Connection Manager client is installed during the main software installation. The link_connect_mgr license
is required to run the client from a schematic page. Connection Manager client and server installations are not
related to the client-server installation of the EDA software.

EDA Software Version Requirements

The Connection Manager client and server software must be from the same or compatible release. If you have been
using an older release of Connection Manager, then you install ADS 2008 on a client system, you also must install a
compatible release of the server software. Since the Connection Manager server was not updated for ADS 2008, the
compatible release for ADS 2008 is 2006 Update 3.
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Installation Package Overview

The Connection Manager server installation installs all the software necessary to enable the EDA software-supplied
measurements. This includes:

e Run-time versions of the Agilent Test and Measurement Programmer's Toolkit. This includes the most recent
version of VISACom available when the Toolkit was released. The latest version is available from the Agilent
Developer Network at:
http://adn.tm.agilent.com

e The Agilent IO Libraries

e ADS Measurement Libraries

e Run-time versions of Microsoft .NET, suitable for running .NET application

e The Connection Manager server

Installation Types

Complete

The Complete installation installs all program features in the default installation directory C:\Program
Files\Agilent\Connection Manager Server.

Custom

The Custom installation lets you define the installation directory and choose the optional program features, such as
the ADS Measurement Library, Connection Manager documentation, Ptolemy VEE Link Server, and VEE Service Control

Panel Application.

Installing the Server

Ensure that your PC workstation meets the system requirements.
Insert the Connection Manager Server 2006 Update 3 Installation Disc into the workstation CD-ROM drive.

When the installation wizard prompts you, choose the type of installation.
Follow the command prompts to complete the installation.

PR
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1. When the system reboots, Connection Manager Server starts and the Windows Security Alert dialog appears.
= Windows Security Alert E|

1o help protect your computer.. Windows: Firewall has blocked
7 zome features of this program,

Do you want to keep blocking this program?

Marme:  Agilent Connection Manager

|i:\Program Files\agilert Cann

Publizher. Agilent Technologies

[ Keep Blacking ][ Urblock. H Ask Me Later ]

Windows Firewall has blocked thiz program from accepling connections from the
Internet ar a network. | you recognize the program or trust the publizher, you can
unblock. it. When should | unblock. & program?

2. In the Windows Security Alert dialog, click Unblock.
This creates an exception in the Windows Firewall that allows network connections through the firewall to the
Connection Manager server.

This completes the installation process. To connect instruments to the server workstation, complete the steps in
Configuring the Server 10 on the PC.

Configuring the Server IO on the PC

Prior to using Connection Manager for the first time, you must configure the 10 on the server workstation.

This section provides instructions for automatically configuring common LAN and GPIB interfaces, and for manually
configuring other interfaces such as LAN/GPIB gateways.

To Configure Common LAN or GPIB Interfaces provides simplified instructions to configure a common LAN or GPIB
interface.

To manually configure an available interface (for example, the Agilent E5810A LAN/GPIB gateway), see To Manually
Configure Other Interfaces.

Additional Resources
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For detailed information on IO configuration, refer to the documentation for the IO libraries.
Choose the IO icon in the tool bar, then choose View Documentation.

Also, see "Configuring IO Interfaces" in Agilent IO Libraries Installation and Configuration Guide for Windows,

available in PDF format at: http://www.agilent.com/find/iolib.

 Note

Connection Manager server does not support the use of National Instruments IO connectivity products. The
Connection Manager server relies entirely on the Agilent IO libraries to provide instrument connectivity, and
cannot offer support for National Instruments IO products.

To Configure Common LAN or GPIB Interfaces

To auto-configure the I/O and connect instruments to the server using a LAN or GPIB interface:

1. In the server's Windows system tray, select IO > Run IO Config.
This opens the I0 Config dialog. The Available Interface Types group box lists the 10 types supported by the
Agilent IO Libraries. List entries with and asterisk 7.7 can be automatically configured in step 2.

2. To automatically configure common LAN and GPIB interfaces in the I0 Config dialog, select Auto Config.
Auto-configured interfaces appear in the Configured Interfaces group box, as shown.
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Agilent IO Libraries Configuration - 10 Config

File Options Help

|0 Config configures and editz Agilent 10 interfaces,

- To configure a new interface, select the interface in byvailable Interface Types' and click "Configure’
- To edit a configured interface, select the interface in ‘Configured Interfaces’ and click 'Edit’

- To automatically configure the interfaces identified with ™, click ‘Auto Config!

- Available Interface Types - Configured Interfaces
VISA Type  Interface Description Y154 Mame  SICL Name
ASHL *RS-232 COM Ports - GPIBD gpibl * ke Config

ASAL VISA LAN Client (e.g. E58 : g
GPIEB FE2ER0 PCI GRIB Card an
GPIB GPIE Using NI-488.2 Usen ush o |

GPIB B2341 154 GPIE Card
GPIB B2357 USE to GFIB

GPIB YISA LAN Client (e EBE Help |

GPIBAxI GPIBAH Command Madu

TCRIP ALAM Client [LAM [Retrurme
LISE *USE Instruments

USE WISA LAN Client far ISE
Wl *E8497 IEEE-1394 ta Vil
n'a L&AM Server [PC as Server ™

B | Benee

*MNOTE: Auto Canfig will configure interfaces identified with an ™

If you encounter a problem

For GPIB interfaces, ensure that the GPIB interface is installed/connected to the server.

For LAN interfaces, the I0 auto-configuration routine creates a TCPIP network tunnel and displays TCPI P | an in the
Configured Interfaces group box. The routine creates only one TCPIP interface regardless of the number of LAN cards
installed on the server workstation.

Follow the steps in To Connect Instruments to the Server through the LAN to complete the LAN interface
configuration.

To Connect Instruments to the Server through the LAN
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Unlike GPIB interfaces where instruments communicate directly with the server via an exclusive bus, the Agilent IO
libraries do not dynamically discover instruments connected to the server via LAN. You must manually add LAN
devices to the server I0.

To add LAN devices:

PwNE

5.

In the IO Config dialog, highlight TCPIPO in the Configured Interface group box and click Edit.

In the LAN Client dialog, click Edit VISA Config.

In the TCPIP devices dialog, click Add device.

In the Add a TCPIP device dialog Machine Name/IP field, enter the IP address of the instrument you would like to
connect to the server and click OK.

LAN Client

Questions? Press the Help button balaw,
Fecommended default values are shown,

Add a TCPIP device

TCPIP devices

Enter the address of this device:
S TCFIP Machine HamedIP  Device Mame k
Server 1 [ TCPIPD: [212Baz24zEEs - “INSTR Cancel_ |
Client Ti |TEF'|F'I:I::2'| 2.53.243.699::inst0 2IMSTR
v Emors
Log Add device
1
a Femaove device
;

In the TCPIP devices dialog, click OK.
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LAN Client X

[uestionz? Prezs the Help button below.
Recommended default values are shown.

SICL Interface Mame: Ilan oK |
Y154 Interface Name: ITI:F'IF'EI :I

TCPIP devices

TCPIPO INSTR devices present: 0K t |
I} |TCPIPO:21253.243.699 instD-INSTR

Cancel

¥

Add device

Remove device

6. In the LAN Client dialog, click OK.
7. In the IO Config dialog, click OK.

If you encounter a problem

Ensure the following conditions are met:

The server is connected to the LAN.

The instrument is connected to the LAN.
The instrument line power is switched on.
The LAN is operational.

To Manually Configure Other Interfaces

This section explains how to manually configure an IO that cannot be auto-configured by the Agilent IO Library. This
section explains how to configure a LAN/GPIB gateway, such as the Agilent E5810A.

To manually configure a LAN/GPIB gateway.
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1. In the Windows system tray, select IO > Run IO Config.

2. In the Available Interface Types group box, highlight VISA LAN Client Interface (E5810A) and click Configure.

3. In the VISA LAN Client Interface (LAN to GPIB) dialog Local Settings group box, use the scroll box to choose a
VISA Interface Name.

4. In the Remote Settings group box, enter the hostname or IP address of the LAN/GPIB gateway.

5. In the Remote Settings group box, enter the SICL interface name assigned to the LAN/GPIB gateway (or other
network interface device) and click OK.
During the process of configuring the LAN/GPIB gateway, you must assign a SICL interface name to the device.
You must enter the same SICL interface nhame in the Remote SICL Interface Name data entry field.

Agilent 10 Libraries Confipuration - 10 Config
VISA LAN Client Interface (LAM to GPIB)

I0 Conbg configures and edis| 0 ustions? Prags the Help button bslow. Recommended defaul valuss st shown,

Toedta c-:_h‘igued ke
o | Looisatna BN
WISA, Interface Name; GPIE3 =
Avvailable Irterface Types I j
WS4 Type  Intetface D) Cancel
ASAL YRRl LAN Chent SICL Interface Name: fian il
ASAL WISA LaN
GFE |20 PO . Help |
GPIE ‘GPE s | Fiemote Seltings
GPIE a23d1 | The remote SICL interface must be a GRIB interface. Defake
GPIB 82357 US Remcte Hoa elau |
D Addere . |169.254178.34
GPIB-H] GFIBA] '
TCRi= "LAM Chier]
5B USE Izt Remote SICL Intedace M ams: IngD
USE WISA LAN
Wl "EB4T IE
n/a LAM Server IPC az Server @ |

*MHOTE: Auto Config will configure interfaces idenbfied with an ™

6. In the VISA LAN Client Interface (LAN to GPIB) dialog, click OK.

To exit the I0 configuration without connecting instruments to the server, in the IO Config dialog click OK. To connect
instruments to the server, follow the steps in To Connect Instruments to the Server through the LAN.

If you encounter a problem

Ensure the following conditions are met:

e The server is connected to the LAN.
e The LAN is operational.
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Using Connection Manager with Windows XP Service Pack 2

By default, computers using Windows XP Service Pack 2 will not allow access to the Connection Manager server and
VEE Service through the firewall.

If you have upgraded from another operating system version to Windows XP Service Pack 2, you must enable
connections to the PC hosting the Connection Manager server and/or VEE Service by listing them as exceptions to the
firewall.

To enable network connections to Connection Manager server (and VEE Pro, if necessary) through the firewall:

1. In the Windows menu bar, choose Start > Settings > Control Panel.
2. In the Control Panel dialog, click Windows Firewall.

A

File Edit Wiew Faworite

B Control Panel

Tools Help
3 __? j.‘:Search A Folders i

D‘ Cankral Panel
ﬂ"l Control Panel AL

[} Switch ta Category View

See Also

.

Address

L Syskem

;Taskhar and Start Menu
84 User Accounts

HVEE Service Manager

Windows Firewal
= Wireless Network Setup ‘Wizard

& Windows Update
L) Help and Support

3. In the Windows Firewall dialog, ensure that the Don't allow exceptions checkbox is unchecked.

104



Advanced Design System 2008

*= Windows Firewall X

General :E:-:::epticuns Advanced

Wirdows Firewall i helping b piatect your PC

Windows Firewall helps protect vour compater by preventing unauthonzed users
from gaining access to your compuker thaough the Intemet or a netwark.

@ (®iDn [recommended}

Thiz zetting blocks all outside sources from connecting to thiz
computer, with the exception of those selected on the Exceptions tab.

[ ] Don't allow exceptions

Select this when pou connect to public networks in less secure
lozations. such az arpoits. You will not be notified when Windows
Firewall blocks programs. Selechons on the Exceptions tab will be
ignored.

@ ) Dff [not recommended]

Avoid uzing this setting Tumang off Windows Firewall may make this
computer more vulnerable bo vinuses and intruders.

What elze should | know about Windowes Frewall?

[ (K] i [ Cancel

4. In the Windows Firewall dialog, click the Exceptions tab.
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*= Windows Firewall X

General | Exceptions I.ﬁ.dvanced:

Windows Firewall iz blocking incoming network, connections, except for the
programsz and zervices selected below. Adding exceptions allows zome programsz

b wiark, better but might increaze your zecurity rizk.

Frograms and Services:

Hame

[ File: and Printer Sharing
Femate dssistance

[ Remote Dezktop

(1 UPHP Framework,

| AddPogam.. | | addPot. || Edt. |

Digplay a notfication when Windows Firewall blocks a program

"What are the rizks of allowing exceptions?

k. ] [ Cancel

In the Exceptions tab, click Add Program.

In the Add a Program tab, click Browse.
Use the Browse dialog to enter the Connection Manager Server installation directory (by default, <installation

drive>\Program Files\Agilent\Connection Manager Server).
From the Connection Manager Server installation directory, choose MsmtSrvr.exe and click Open.
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Browse

Look in; | ) Connection Manager Server b = s Pl A
: i:,:]Dncumentatbun
L EB i Importedassemblies
My Fecent M cmcontroller.exe
Documents [T MsrkSrve.exe

7 i Mk Srvr, B0
tj [jﬂuaiarvi:e.axa

[™visalnstFinder .exe

My Documents

My Computer

File name: MsmtSrmexe it ' | Dpen ]
Files of type: Applications [ eve.” com™ icd) |

kdy Metwork,

9. In the Add a Program tab, click OK.
The Windows Firewall dialog Exceptions tab shows the MsmtSrvr.exe exception.
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= Windows Firewall

| General | Erceptions I.ﬁ.dvanced:

Windows Firewall iz blocking incoming network, connections, except for the
programs and services selected below, Adding exception: allows zome programs
ko work, better but might increase your secunty nizk,

Programs and Services:

M ame

[JiFile and Printer Sharing
b zmitS rer. e

Remate Azsistance

[ Remate Desktop

O UPAP Frameswark,

[ Add Program. .. ] [ Add Paort....

Dizplay a notification when Windows Firewall blocks a program

What are the rizks of allowing exceptions?

[ ak. ][ Cancel ]

If you are using VEE Service, in the Exceptions tab, click Add Program....

In the Add a Program tab, click Browse.

Use the Browse dialog to enter the VEE Pro installation directory (by default, <installation drive>\Program
Files\Agilent\VEE Pro 7.0).

From the VEE Pro installation directory, choose veesm.exe and click Open.

In the Add a Program tab, click OK.

In the Windows Firewall dialog, click the OK.

Connections to the PC hosting the Connection Manager server and/or VEE Service are now enabled as firewall
exceptions.

Running the CM Server as a Windows Service

By default, the Connection Manager server runs as a Windows application. If preferred, the server can run as a
Windows service.
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For instruction on configuring the server to run as a Windows service, see Running the Server as a Windows Service in
the Connection Manager documentation.
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